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X-ray powder diffraction (XRD) has been used for several decades to identify and measure the mass fractions of various crystalline 
phases in portland cement. More recently, a combination of scanning electron microscopy with X-ray microanalysis (SEM/XMA) and 
image processing has been shown to enable the quantitative characterization of microstructural features in these materials. Each
technique can furnish some information that is not accessible from the other. For example, SEM/XMA can identify the microstructural 
location and morphology of calcium sulfate minerals, while only XRD can determine the relative abundance of the different forms of
calcium sulfate, such as gypsum (CaSO4 · 2H2O), bassanite (CaSO4 · 1

2 H2O), and anhydrite (CaSO4). This document describes how 
XRD and SEM/XMA can be used together to establish and validate the portland cement phase composition and microstructure.
Particular emphasis is laid on step-by-step procedures and best practices for XRD specimen preparation, data collection, and 
intepretation. Similar detail has been given recently for SEM/XMA [Stutzman et al., NIST Tech Note 1877, U.S. Department of
Commerce, April 2015]. The methods are demonstrated for three portland cement powders, through which apparent discrepancies
between the results of the two methods are identified and procedures are described for resolving the discrepancies and quantifying 
uncertainty.
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1. Introduction

The first application of X-ray powder diffraction (XRD) to portland cement powder was made by
Brownmiller and Bogue in 1930 [1], only 35 years after X-rays were discovered. At the time, portland 
cement clinker was thought to be composed primarily of either a complex single compound containing 
lime, alumina, and silica, or separate silicate compounds containing varying amounts of lime. In their 
groundbreaking study, Brownmiller and Bogue compared X-ray diffraction patterns obtained from a 
commercial portland cement clinker to those obtained from individually synthesized phases. The 
comparison (Fig. 1) demonstrated the presence of tricalcium silicate (alite) as the primary clinker phase, as 
postulated previously by Henri Le Chatelier [2, 3] and observed by Törnebohm [4], and also indicated 
phases that are now called belite (dicalcium silicate), tricalcium aluminate, ferrite, and periclase. 
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Fig 1. X-ray powder diffraction pattern first published as Fig. 1 in Ref. [1], obtained using a Debye-Scherrer camera, comparing a 
mixture of individually synthesized dicalcium silicate and free lime (upper) to synthesized tricalcium silicate (lower). The 
dissimilarity in the patterns proved that tricalcium silicate in clinker is not a mechanical mixture of dicalcium silicate and free lime. 
 
 
      ASTM Subcommittee C01.23 on Compositional Analysis of Hydraulic Cements established a Task 
Group on XRD in 1978 to develop a standard test method for using XRD to determine the proportion of 
phases in portland cement and portland cement clinker. Their work led to the creation of such a test 
method, ASTM C 1365, in 1998 [5]. During the 20 years of work leading up to that test method, 
quantitative XRD analysis of cement transitioned from measuring the area under a single peak for a given 
phase to whole-pattern fitting using Rietveld refinement [6]. Improvements in structural models for the 
major mineral phases has led to greater accuracy and confidence in results of the methods. Today, XRD is 
used routinely in the cement industry for bulk phase analysis. 
      Quantitative microstructure imaging of cement, using scanning electron microscopy in combination 
with X-ray microanalysis and image processing, is a more recent development in compositional analysis of 
cement, although its roots may be traced back to optical microscopy techniques first used by Le Châtelier 
[3] to investigate portland cement clinker composition. Quantitative optical microscopy methods began 
with Delesse [7], who recognized the relationship between the area fraction of a mineral in a 2D section 
and its 3D volume fraction in the material. Microscopic phase composition analysis evolved by 
subsampling the microstructure through linear traverse and point sampling to obtain quantitative estimates 
of mineral abundance. These methods are now more than a century old but are still used today in many 
disciplines. 
      Scanning electron microscopy combined with X-ray microanalysis (SEM/XMA) and image analysis 
can now produce a set of high-resolution image fields from a single material. These image sets are 
sufficiently consistent that feature extraction and quantitative measurement by digital image processing are 
possible. In this case, the mineral constituents are digitally traced and extracted from the bulk 
microstructure by a set of operations termed image processing and image analysis, which supplant the 
older operations with semi-automated pixel counting to determine phase abundance. Images can therefore 
be analyzed more rapidly and more consistently than in the past, so that quantitative microstructure 
imaging is a viable and powerful method of performing phase analysis and extraction of microstructure 
features. 
      Despite technological and analytical advances in both XRD and SEM/XMA in the last several decades, 
each method has its unique advantages and limitations. Applying both methods to characterize a material 
can often provide a more complete and accurate picture of the phase abundance than can be obtained with 
either method alone. For example, certification of the SRM portland cement clinker phase abundance is 
based upon a consensus mean and combined uncertainties of both XRD and SEM/XMA analyses [8]. 
      SEM/XMA can identify the presence, location, and average domain size of a phase that contains 
calcium as the primary component, without any alkali, sulfur, aluminum, iron, or magnesium. However, 
that method cannot readily determine whether such a phase is free lime (CaO), portlandite (Ca(OH)2), or 
calcite or aragonite (CaCO3). Free lime is often present in clinker because of incomplete conversion of raw 

http://dx.doi.org/10.6028/jres.121.004
http://dx.doi.org/10.6028/jres.121.004


 Volume 121 (2016) http://dx.doi.org/10.6028/jres.121.004 
 Journal of Research of the National Institute of Standards and Technology 
 
 
 

 49 http://dx.doi.org/10.6028/jres.121.004 

 

materials during the clinkering process, but free lime is highly reactive to moisture and carbon dioxide, 
even at ambient atmospheric levels, and consequently may partially convert to portlandite during grinding 
or handling. Calcite or aragonite may be present in cement as an additive but may also form from free lime 
by reaction with carbon dioxide during storage or handling. XRD, especially in combination with 
thermogravimetric analysis, can help resolve the issue and provide estimates of the relative abundance of 
free lime, portlandite, calcite, and aragonite because these phases are readily distinguished from each other. 
      As another example, the mineral arcanite (K2SO4) is typically present in small amounts, usually less 
than 1 % by mass, in portland cement clinker. Although a small fraction of the solid mass, arcanite reacts 
rapidly with water, has a major influence on the pH of the pore solution at early ages, and thereby also 
influences early-age reaction rates and strength gain. However, the peaks of arcanite in an XRD pattern 
nearly coincide with those of dolomite (MgCa(CO3)2), which is sometimes also present in cement as a 
mineral additive. Determining the relative abundance of arcanite and dolomite by XRD alone is 
problematic because of the peak overlaps, but SEM/XMA can easily identify and distinguish dolomite and 
arcanite within the microstructure. 
      The presence of syngenite, as seen in XRD patterns, suggests possible pre-hydration or cement storage 
issues as it generally represents a reaction between arcanite (or other alkali sulfates) and gypsum. Phase 
chemistry (K2CaSO4 · 2H2O) would make it appear similar to some of the alkali sulfates in SEM imaging, 
albeit darker because of the water. The XRD pattern exhibits diagnostic diffraction peaks at 0.571 and 
0.316 that are useful in syngenite identification. 
      These examples illustrate how XRD and SEM/XMA can be used in a complementary way for a more 
complete quantitative phase analysis of portland cement and portland-cement clinker. The two methods can 
also be used as a check on each other for consistency. Greater confidence in the results is warranted if both 
methods provide similar results, while discrepancies between the two methods, when the causes are 
investigated further, can reveal additional insights about the nature of the material. 
      This report describes XRD and SEM/XMA imaging and analysis procedures for quantitative phase 
analysis of portland cement. Emphasis is placed on documenting the procedures and best practices for XRD 
sample preparation, data collection, and interpretation. A full and detailed description of procedures for 
SEM/XMA of cementitious materials has been given recently [9], so those procedures will be described 
much more briefly here. Both XRD and SEM/XMA are used to characterize and compare three commercial 
portland cements. 
      Microstructure imaging and image analysis have always had—and likely will continue to have—a 
partially subjective aspect. Microstructure is often characterized by significant chemical and spatial 
heterogeneity that can be measured only in a statistical sense. In addition, both an electron beam’s 
interaction with the specimen and image digitization result in volume being homogenized over small 
elements that cannot be resolved more finely than a single pixel. Consequently, phase assignments can be 
uncertain for some pixels, especially for those near the boundary between two phases. The fraction of such 
“borderline” pixels is usually small, but no single objective method is currently available for infallibly 
assigning their phase identity. Instead, for these cases the user must appeal to several types of possibly 
inconsistent data about a pixel or pixel grouping, such as its backscattered contrast, X-ray element signal, 
and location within the microstructure, and arrive at an informed judgment based on experience. Therefore, 
phrases used in this paper, such as “accurate phase assignment,” or “incorrectly assigned pixels” should be 
understood to mean that the informed judgment of an experienced user is required to make those 
determinations. 
 

 

2.  XRD Procedures 
 
      Figure 2 shows an illustration of an X-ray diffractometer, which identifies the major parts and 
definition of the diffraction angle 2θ, to which this section will refer. Diffraction corresponds to 
constructive interference of X-rays scattering from a sample, and follows Bragg’s law, 
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Fig. 2. Illustration of an X-ray diffractometer geometry. 
 
 
where θ is the diffraction angle indicated in Fig. 2, n is an integer, λ is the wavelength of the X-rays, and d 
is the distance between two adjacent parallel lattice planes in the crystal structure [10-12]. 
 
2.1  Sources of Error 
 
      A comprehensive assessment by Schreiner et al. [13] of random and systematic errors in XRD analysis 
concluded that the two most severe errors, by far, are related to improper specimen preparation. According 
to that study, the greatest source of error is displacement, which means the specimen height is above or 
below the plane of zero height. Displacement causes a systematic shift in the measured angle 2θ at which a 
given Bragg diffraction condition is satisfied, but does not affect the peak intensities significantly. 
      The second greatest source of error in XRD analysis is preferred orientation. If the powder particles in 
the specimen are randomly oriented, then the same number of particles, on average, contribute to the 
diffracted intensity for a given d-spacing at a given detector angle 2θ (see Fig. 2). Consequently, randomly 
oriented particles produce predictable relative intensities of the different diffraction peaks for a given 
mineral. Quantitative analysis by Rietveld refinement of a whole diffraction pattern is based on the 
assumption of randomly oriented particles. Therefore, any departure from random orientation will alter the 
relative peak intensities from their expected values and therefore may result in a bias in quantitative 
measurements of phase abundance. Figure 3 shows the bias in diffraction peaks for alite due to preferred 
orientation. The pattern in black was obtained using a specimen for which preferred orientation was 
minimized by grinding and careful pressing, and the red pattern was obtained using a coarser specimen and 
a pressing technique that intentionally induced strong preferred orientation. The effect is evident at 
2θ = 32.1°, where the red peak has significantly greater intensity than in the sample without preferred 
orientation. In principle, this kind of bias in peak intensities can also be caused by very coarse powders, for 
which there may not be sufficient crystal orientation sampling to achieve the expected peak intensities. One 
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Fig. 3. Part of powder diffraction patterns obtained for alite using a specimen with minimum preferred orientation (black) and 
intentionally induced preferred orientation (red). For the peaks 32.1° and 32.7, the intensity ratio should be about 1.2, whereas the the 
red pattern has a peak intensity ratio of 1.5. 
 
 
can test for the effect of coarseness by obtaining patterns on the same powder sample that has been 
removed and repacked in the sample holder; each repacking should produce a different ratio of peak 
intensities if the bias is caused by coarseness. 
      Some preferred orientation is difficult to avoid for powders with anisometric grains, such as platelets or 
needles, because they tend to naturally pack with the particles aligned. Minerals with strong cleavage 
planes, such as alite, calcite, and gypsum all are susceptible to preferred orientation. Corrections for 
preferred orientation are available in most XRD analysis software, but they seem to be most effective after 
steps have been taken to minimize orientation effects by careful specimen preparation, as described in Sec. 
2.3. 
      A third potential source of error in XRD stems from the limited interaction depth of the X-ray beam 
with the specimen. The interaction depth varies with the X-ray absorptivity of the powder specimen while, 
for a fixed divergence slit setting, the interaction volume remains constant. A typical interaction depth for 
cement powder, assuming 2θ = 40°, is about 15 µm. For multiphase powders like cement and ground 
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clinker, oversampling of one or more phases can easily occur if the phase domains are comparable in size 
to the interaction depth. This would seem to indicate that powders should be ground to an average size of 
10 µm or smaller to produce accurate and repeatable diffraction intensities [14]. Achieving this fine a 
cement powder, for which the as-received particle size is usually 25 µm to 40 µm, may result in damage to 
the phases and a consequent peak broadening without proper grinding procedure. In-house evaluation, 
specific to the grinding mill and materials, is needed to determine the amount of grinding required to 
produce minimal preferred orientation and reproducible peak intensities [15]. 
      The magnitude of all three of these errors can be reduced significantly by proper specimen preparation. 
Section 2.3 discusses additional aspects of specimen preparation that are most important for obtaining 
accurate, reliable XRD results. 
 
2.2  Chemical Extractions 
 
      In multiphase powders such as portland cement or ground clinker, the Bragg condition may be satisfied 
for different lattice planes in different minerals at the same, or nearly the same, 2θ angle. The 
corresponding overlap of peaks are often difficult to deconvolute, and so both qualitative and quantitative 
analyses are challenging. One solution to this problem is to perform a series of chemical extractions on the 
powder, by which certain minerals can be selectively dissolved [16]. The extractions cause a relative 
concentration of the remaining phases and therefore enable improved detection levels. In addition, powders 
subjected to chemical extraction provide a second set of data that can be used as a check of the XRD 
patterns obtained using the original powder. XRD patterns using powders with and without chemical 
extractions can be compared to reduce the influence of peak overlap and thereby facilitate qualitative 
analysis. Moreover, by calculating the mass loss caused by a given extraction procedure and calculating 
weighted mass fractions from patterns from different extraction residues one can make quantitative 
measurements of the phase abundance of minerals that otherwise would be difficult due to peak overlap. 
The following selective extractions reflect our lab protocols, modified from [16] to provide sufficient 
residue volume to prepare a specimen mount for XRD. 
 
2.2.1  Salicylic Acid and Methanol Extraction 
 
      The salicylic acid and methanol (SAM) extraction dissolves alite (C3S1), belite (C2S), and free lime 
(CaO), leaving behind a residue of the tricalcium aluminate (C3A) and ferrite (C4AF) interstitial phases as 
well as minor phases including periclase (MgO) and alkali sulfates such as arcanite ( KS ), thenardite 
( NS ), and langbeinite (KM2 3S ), calcium sulfates (gypsum, bassanite, and anhydrite), and carbonates 
(calcite and dolomite). 
      The extraction solution is prepared with 20 g of salicylic acid in 300 mL of methanol. Into this solution 
is stirred a known mass of powdered clinker or cement, usually about 5 g, in a stoppered flask for about 2 
h. After allowing the suspended particles to settle for about 15 min, the solution is vacuum filtered using a 
0.45 µm filter and a Buchner funnel. Finely ground powders can clog the filter and require a long time to be 
separated. However, very coarse powders may not have sufficient surface area to facilitate the dissolution 
of phases to be extracted. For stubborn samples, grinding the powder to an average size of 25 µm usually 
provides sufficient surface area while reducing the tendency for clogging. The residue is washed with 
methanol and dried at a temperature no higher than 65 °C to preserve the bassanite and gypsum. The 
residue mass after drying is recorded to calculate the percent insoluble residue, which will subsequently be 
used to recalculate the phase mass fractions on a whole-cement basis, and the residue is stored in a vacuum 
desiccator. 
      Other reagent compositions can be used to achieve alternate phase differentiation in the extraction 
residues. More detailed descriptions of such extraction methods can be found in the literature, including 
selective extractions to produce a residue enriched in belite [11, 17]. 
 

                                                 
1 Conventional cement chemistry notation will be used where  it is unlikely to cause confusion: C = CaO, S = SiO2, A = Al2O3, F = 
Fe2O3, K = K2O, N = Na2O, M = MgO, and 3S = SO . 
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2.2.2  Potassium Hydroxide and Sucrose (KOSH) 
 
      The KOSH extraction dissolves the C3A and C4AF interstitial phases, leaving a residue of silicates, 
minor phases, and carbonates. As described in the previous section, grinding the powder to an average 
particle size of about 25 µm provides enough surface area for efficient dissolution while reducing the 
tendency for clogging the filter afterward. 
      The extraction solution is prepared with 7.5 g each of KOH and sucrose in 75 mL of distilled water, 
which is then heated to 95 °C. Into this solution is stirred a known mass of powdered clinker or cement, 
usually about 2.5 g. After about one minute, the solution is vacuum filtered using a 0.45 µm filter and a 
Buchner funnel. The residue is first washed with 2.5 mL of distilled water, and then washed with 25 mL of 
methanol. The residue is dried at 65 °C. The residue mass after drying is recorded, and the residue is stored 
in a vacuum desiccator. 
 
2.3  Specimen Preparation 
 
      Powder XRD specimen preparation involves the packing of powder particles into a cavity holder which 
is subsequently placed in the diffractometer. Careful preparation and packing of powder, to obtain a smooth 
top surface that is coincident with the specimen holder to minimize specimen displacement error, is critical 
to the ease of interpretation of X-ray diffraction patterns for quantitative analysis. 
 
2.3.1  Grinding 
 
      Reducing powder particle size by grinding can reduce the tendency for preferred orientation by 
breaking up anisometric particles into smaller, more random shapes. The modified particle size distribution 
produced by grinding promotes better packing characteristics that lead to smoother surfaces and a reduced 
likelihood of displacement. Furthermore, portland cement and ground clinker particles are typically 
composed of multiple phases, so grinding can also promote representative phase sampling by reducing the 
average phase domain size. In this way, a representative proportion each phase is more likely to fit within 
the beam interaction volume discussed in Sec. 2.1. 
      Figure 4 shows the change in cumulative particle size distribution (PSD) of an as-received portland 
cement as it is wet-ground2,3 in isopropyl alcohol for 3 min, 6 min, or 9 min. Grinding reduces the median 
effective particle diameter (d50) from about 15 µm to about 6 µm, which is significantly less than the 
interaction depth. 
      Grinding also improves the homogeneity of the phase distribution and the quality of the top surface of 
the powder packing. Figure 5 shows optical micrographs of a packed surface of an as-received cement and 
of the same cement that has been ground until 70 % of the particles have an effective diameter less than 
10 µm. Grinding appears to produce a finder dispersion of dark and light domains, which suggests that the 
phase distribution is more homogeneous. In addition, although more difficult to perceive in the 
micrographs, the ground packing has a smoother surface. 
 
2.3.2  Packing 
 
      As already documented, denser and more homogeneous packings can be produced with finely ground 
powders, but good technique is still essential to producing a well-packed specimen with a smooth top 
surface. A high-quality packing requires the correct quantity of powder to be added to, and evenly 
distributed within, the specimen holder cavity. Determining the correct quantity of powder is a trial-and-
error process. A good practice is to first loosely overfill the cavity with powder. The powder can then be 
evenly distributed within the cavity by lightly and evenly tapping the surface of the powder with the edge 

                                                 
2 McCrone Micronizing Mill, https://www.mccrone.com/mccrone-micronizing-mill 
3 Certain commercial equipment, instruments, or materials are identified in order to specify the experimental procedure adequately. 
Such identification is not intended to imply recommendation or endorsement by the National Institute of Standards and Technology, 
nor is it intended to imply that the materials or equipment identified are necessarily the best available for the purpose. 

http://dx.doi.org/10.6028/jres.121.004
http://dx.doi.org/10.6028/jres.121.004


 Volume 121 (2016) http://dx.doi.org/10.6028/jres.121.004 
 Journal of Research of the National Institute of Standards and Technology 
 
 
 

 54 http://dx.doi.org/10.6028/jres.121.004 

 

 
 
Fig. 4. Differentiated particle size distribution (PSD) of cement powder as a function of wet grinding time. PSD was measured by 
laser scattering of a dilute particle suspension in isopropyl alcohol. Each point shown is an average of six replicate measurements, 
with measurement uncertainty on the order of the line marker diameter. 
 
 
 
 

         
 
                                                 (a)                                                                                                    (b) 
 
Fig. 5. Optical micrographs of cement powder packings, each with a field width of 2 mm. (a) As-received cement powder, and (b) the 
same powder ground until 70 % of the particles had an effective diameter less than 10 µm. 
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of a rigid, straight tool; a glass microscope slide or small lab spatula are good choices. When the cavity has 
been evenly filled with the powder, the excess powder can be decreased gradually by lightly scraping it 
away from the top with the tool edge until the top surface is just a little higher, by about 2 mm, than the top 
of the cavity. Once this is achieved, the tool can be used to evenly scrape away a narrow border of powder 
around the cavity perimeter; the powder surface within this border should coincide with the top of the 
cavity, leaving a slightly elevated plateau of powder in the center of the cavity. At this point, a rigid, 
smooth flat surface can be used to apply vertical pressure to the plateau until the top surface of the entire 
packing coincides with the top of the cavity. A glass microscope slide provides an ideal surface for this 
compaction step. It is tempting to slide the compaction tool back and forth horizontally during this step, but 
this is a poor practice because it increases the likelihood of inducing a surface texture corresponding to 
preferred orientation. Some practitioners address this by using a rougher tool surface, such as a frosted 
glass slide or a piece of filter paper, which may reduce the tendency to orient fragments parallel to cleavage 
planes. 
      Cement and clinker specimens are sensitive to moisture, so they should be analyzed as rapidly as 
possible after specimens have been prepared. If some delay between preparation and analysis is 
unavoidable, the specimens should be stored in a desiccator. Some hydration of the more reactive 
constituents (e.g., free lime) will inevitably occur. However, small amounts of prehydration may have 
negligible impact on XRD patterns if the amount of reaction is comparable to the sensitivity limits of the 
instrument. Free lime will react with moisture to form portlandite, identifiable by a weak and possibly 
broad diffraction peak at d-spacing of 0.490 nm (18.07° 2-θ). The portlandite may subsequently carbonate 
to form calcite; low levels would be difficult to identify because the primary peak of calcite (0.304 nm, 
29.40° 2-θ) overlaps one of the primary alite peaks. 
 
2.4  Data Acquisition 
 
      Details about the instrumentation for acquiring powder XRD patterns, including the functions of each 
part, can be found in Ref. [18]. In this paper, a θ-θ goniometer is used with a copper X-ray source operating 
at 35 kV and 45 mA, a Ni foil to remove Cu Kβ radiation leaving Cu Kα radiation, and a 1-dimensional 
strip detector. Scans are typically collected from 10° 2-θ to 77° 2-θ using a step size of 0.017° at a scan 
time of 30 min. A 0.4° divergence slit, 6 mm receiving slit and 22 mm detector slit and 4° Soller slits on the 
divergent side of the goniometer complete the configuration. 
      As with any powder sampling method, one should ensure that the sample is representative of the larger 
material. One way to do this is to acquire replicate data scans, each using fresh mounts of the available 
powder. If the powder is homogeneous and the mounting scheme is consistent, little difference in the 
acquired patterns will be observed among the replicates. 
 
2.5  Phase Identification 
 
      Crystalline components may be identified using the traditional approach of measuring location and 
relative intensities of the most intense diffraction peaks. An alternative for the complicated cement 
diffraction patterns is to employ diagnostic characteristics of the composite diffraction pattern, which may 
be either a single key diffraction peak, or groups of peaks that are typical for a specific mineral, with 
subsequent confirmation using a powder diffraction pattern database. This approach is facilitated by use of 
a table for tentative mineral identification, such as Table 1, where the peak locations for resolved, or mostly 
resolved, diffraction peaks considered useful in their identification are listed along with their d-spacing in 
nanometer units and angle as degrees 2-θ for Cu Kα radiation. For example, starting from the low angle 
side of the diffraction pattern, a diffraction peak centered at approximately 11.59° 2-θ corresponds to the 
most intense (100) peak of gypsum. Examining the pattern for additional gypsum peaks at higher angles 
adds confidence to the identification. Keep in mind that peak positions may vary with phase solid solution 
and relative intensities may vary depending upon the degree of randomness of the specimen mount. The 
peak location provides a tentative identification, which is subsequently confirmed after comparing to the 
ICDD database.4 
                                                 
4 ICDD Powder Diffraction Database, International Centre for Diffraction Data, www.icdd.com 
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Table 1. Diagnostic diffraction peaks for cement phase identification using Cu Kα radiation. Numbers in parentheses next to each 
mineral name is the theoretical intensity as a percentage of the intensity of the most intense peak for that phase in a pure phase pattern. 
 

           d-spacing (nm)        2-θ (degree)              Phase 
0.949 9.31 syngenite (40) 
0.763 11.59 gypsum (100) 
0.725 12.20 ferrite (45) 
0.571 15.50 syngenite (55) 
0.490 18.10 portlandite (74) 
0.428 20.72 gypsum (100) 
0.424 20.96 aluminate, cubic (6) 
0.418 21.26 arcanite (28) 
0.416 21.35 arcanite (23) 
0.408 21.77 aluminate, cubic (12) 
0.380 23.40 gypsum (17) 
0.367 24.23 aphthitalite (20) 
0.365 24.35 ferrite (16) 
0.350 25.45 anhydrite (100) 
0.347 25.67 bassanite (40) 
0.331 26.89 langbeinite (95) 
0.327 27.24 langbeinite (80) 
0.326 27.31 langbeinite (80) 
0.323 27.64 langbeinite (100) 
0.307 29.11 gypsum (75) 
0.304 29.36 alite, triclinic (55) 
0.304 29.40 alite, monoclinic (40) 
0.303 29.48 Calcite 
0.303 29.50 alite, triclinic (65) 
0.303 29.50 alite, monoclinic (75) 
0.300 29.74 bassanite (80) 
0.300 29.76 arcanite (77) 
0.299 29.91 alite, triclinic (25) 
0.297 30.02 alite, triclinic (18) 
0.297 30.12 alite, triclinic (20) 
0.296 30.16 alite, monoclinic (25) 
0.294 30.38 aphthitalite (75) 
0.290 30.79 arcanite (100) 
0.289 30.96 arcanite (53) 
0.288 31.03 langbeinite (18) 
0.288 31.05 dolomite (100) 
0.288 31.07 belite, β form (21) 
0.284 31.50 aphthitalite (100) 
0.278 32.12 ferrite (25) 
0.272 32.98 aluminate, orthorhombic (65) 
0.271 33.03 belite, α form (100) 
0.270 33.18 aluminate, cubic (100) 
0.269 33.25 aluminate, orthorhombic (100) 
0.264 33.88 ferrite (100) 
0.241 37.36 free lime (100) 
0.211 42.93 periclase (100) 

 
2.6  Data Analysis 
 
      Rietveld refinement is popular because it provides a means to measure pattern intensity and to calculate 
the best-fit set of patterns based upon modified crystal structure models. The method works by generating a 
theoretical pattern based on structural models for each of the phases and then compares this calculated 
pattern to the observed one. Differences between the two can be reduced by altering some of the model 
parameters. The refinement procedure involves minimizing the sum of the weighted, squared differences 
between the observed and calculated peak intensities point-by-point over the entire diffraction pattern [19]. 
The full-pattern approach provides a more precise intensity measurement over that of individual peaks, but 
each crystalline component must be identified and included in the analysis to ensure proper calculation of 
the scale (intensity) factors and phase fractions. This approach has been standardized, as described in 
ASTM C1365 [5, 19]. 
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      The first step is to establish input files that contain parameters that characterize the instrument 
configuration and the set of crystal structures for identified phases, together with structure models that best 
describe the individual phases for each cement. This is accomplished after phase identification using the 
chemical extraction residue patterns to concentrate different phase groups. The KOSH extraction 
concentrates the silicate fraction, and the SAM extraction concentrates the interstitial phases. Variables 
refined for each phase include scale, specimen displacement, background, lattice parameters, and peak 
shapes. Refinement of the aluminum and iron tetrahedral and octahedral site occupancy fractions in the 
ferrite phase may be included in refinements for the SAM extraction residue. This refinement of the site 
occupancy may improve the agreement between the calculated and observed patterns, but the change in 
quantitative phase estimates are, based on personal experience, typically within the single-lab repeatability 
standard deviation. Once refined for the selective extraction residues, the phase parameters are fixed to 
establish starting models that more closely approximate the phases existing in the cements. A correction for 
preferred orientation of alite is also available in the refinement procedure. However, reducing the alite 
preferred orientation as much as possible by careful specimen preparation and mounting (Sec. 2.3) is 
preferred to the application of a correction. Moreover, the published structure model for alite often 
produces calculated patterns that do not accurately match the peak intensities for alite in real clinker. 
However, XRD measurements on a reference clinker [8] using that structure model generate alite fractions 
that are consistent with quantitative microscopy measurements on the same material [20]. Therefore, the 
alite structure model, even with its imperfections, generates little relative bias in phase fraction estimates. 
      One potential source of bias in quantitative powder diffraction is microabsorption, where weakly 
absorbing phases exhibit greater intensities than expected while strongly absorbing phases exhibit lower 
intensities. Previous calculations of the linear absorption coefficients for the cement phases and that of a 
mixture from certification of the original SRM 2686a show that ferrite, periclase, and free lime (when 
present) may be expected to exhibit the greatest estimate uncertainties. Fine grinding reduces 
microabsorption effects, so corrections are not generally needed when this is done. Ultimately, a 
comparison of the XRD and SEM data sets developed by two different individuals working independently 
on SRM 2686a [8] indicated consistent results, with displacement of the means for periclase and ferrite 
opposite to what one would expect for microabsorption effects [21]. 
      Graphical comparison of the observed versus the calculated pattern, the individual phase patterns, and 
residual plots are perhaps the best means by which to judge the quality of the fit. Numerical assessment of 
the fit is made using the chi-squared test, with lower values reflecting better fits. Refinement is stopped 
when the fit cannot be significantly improved. 
 
 
3.  SEM/XMA Procedures 
 
      Step-by-step procedures for quantitative phase analysis by SEM/XMA have been given for portland 
cement clinker in previous reports [9, 22, 23] and so will be described only briefly here. 
      An electron beam’s interaction with the specimen, combined with image digitization, makes it 
impossible to resolve chemical information on a scale finer than a single pixel. This means that phase 
distinction can be uncertain for some pixels, especially for those at the boundary between two phases. 
Although the fraction of such “borderline” pixels is usually small, the user must refer to several types of 
possibly inconsistent data about such pixels when establishing the training classes used to classify the 
phases. These data include backscattered electron contrast, X-ray element intensity, and the pixel’s location 
within the microstructure. Resolving the inconsistencies requires the user’s informed judgment based on 
experience. Ultimately, the classification (also called phase segmentation) based on training classes seeks 
to place each pixel into the class (phase) to which it most likely belongs, and poor segmentations may be 
improved by adding to the training classes and by post-segmentation processing. These procedures for 
obtaining and improving phase segmentations are discussed in detail in the following sections. 
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3.1  Specimen Preparation 
 
      Aside from ASTM C183 [24], no guide or standardized procedure is available for sampling clinker or 
cements to ensure that the SEM sample is representative of the bulk material. Sample splitters or the cone-
and-quarter method [25] may be used to reduce large-volume samples to representative subsamples. The 
powder sample is mounted in a medium-viscosity epoxy5, to preserve the microstructure, to support the 
pore and fracture network during cutting and polishing, and to fill the voids to assist in pore identification. 
      The specimen is cut after the epoxy has cured, using a low-speed diamond saw with ethanol as a cutting 
lubricant to expose a cross section of the material. The surface is progressively ground and polished using a 
sequence of silicon carbide papers and diamond pastes, down to 0.25 µm roughness. The specimen is 
cleaned with isopropyl alcohol and carbon coated after the final polish. 
      Storage in a vacuum desiccator is recommended to avoid reaction with moisture if a significant delay 
between preparation and data collection is unavoidable. In contrast to XRD, even small amounts of 
prehydration of free lime or other clinker minerals will be evident by microscopic examination. 
Prehydration features may be distinguished by their surface being level with the specimen whereas 
hydration after specimen preparation will stand in high relief due to the substantial volume increase. 
 
3.2  SEM Imaging 
 
      High-quality images for quantitative analysis can be obtained with the following SEM operating 
conditions: 

1. 12 kV accelerating voltage,  
2. 2 nA to 4 nA probe current, adjusted to keep a relatively high X-ray count rate with minimal dead 

time,  
3. a scan rate of 5 min/frame for an image size of 1024 pixels × 768 pixels to minimize backscattered 

electron noise,  
4. an accumulation of approximately 15 frames for a single field of view to improve the definition of 

the X-ray (XR) images, and  
5. a magnification of 300×, which provides a spatial resolution of approximately 1.0 µm/pixel, which 

is typically on the order of the beam’s interaction volume within the specimen.  
 
      These settings are a useful starting point to obtain high-quality images, and are judged to represent a 
balance between fast collection times, a match in resolution of BE images with X-ray map (XR) images, 
and instrument stability. 
      The local brightness in a backscattered electron (BE) image is proportional to the average atomic 
number, Z , of the phase in that location, and the XR image reflects element spatial distribution over the 
same field of view. The backscatter coefficient, η, is a measure of the backscattered electron fraction and, 
following Goldstein et al. [26], is estimated using the mass fractions and η values for each constituent. 
Table 2 lists phases found in clinker and cement in descending order of their backscattered coefficient and 
gray intensity. Caution is necessary here because the brightness ranking may change depending upon 
chemistry variability due to impurities; the exact values are not as important as the general ranking of the 
phases in the table. The identification of the individual phases also includes supplemental information such 
as domain shape (e.g., angular or rounded), position within the microstructure (e.g., framework grain, 
matrix, dispersed phase), and bulk chemistry as described in Table 3. 
      The BE contrast between alite and belite is relatively strong, but that between belite and cubic 
tricalcium aluminate is generally too low to rely on contrast to distinguish them. For such phase pairs that 
have similar BE coefficients, or for phases that have BE coefficients too low to be resolved in the BE 
image, XR imaging is used to distinguish them based on their composition. For example, periclase and 
some alkali sulfates often appear black, like the epoxy-filled voids, because of the brightness and contrast 
settings necessary to make the other phases distinct. Combining the XR and BE images facilitates their 
discrimination much better than relying on either image alone. Information redundancies also occur that 

                                                 
5 Epotek 301, Epoxy Technology, Inc., 14 Fortune Drive, Billerica, MA 01821 
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Table 2. Cement phases, compositions, densities, average atomic number, and backscattered electron coefficient ranked according to 
relative SEM BE image brightness [27]. 
 

   Phase      Composition Notation           Density (kg m−3) Z          η 
Ferrite Ca2 (AlxFe1−x)2O5 C4AF 3770 16.65 0.186 

Free Lime CaO C 3320 16.58 0.188 
Alite Ca3SiO5 C3S 3130 to 3220 15.06 0.172 
Belite Ca2SiO4 C2S 3280 to 3310 14.56 0.166 

Arcanite K2SO4 K S  2670 14.41 0.165 
Aluminate-ca Ca3Al2O6 C3A 3040 14.34 0.164 
Portlandite Ca(OH)2 CH 2260 14.30 0.162 

Aluminate-ob Ca3Al2O6 C3A 2560 13.87 0.159 
Aphthitalite K3Na(SO4)2 K3N0.5 S

2 2700 13.69 0.158 
Syngenite K2Ca(SO4)2 H2O K2C S H2 2600 13.60 0.156 
Anhydrite CaSO4 C S  2980 13.41 0.154 
Bassanite 2 CaSO40 · 5 H2O C S H0.5 2700 13.03 0.149 
Calcite CaCO3 C C  2710 12.56 0.142 

Gypsum CaSO42 H2O C S H2 2320 12.12 0.138 
Thenardite Na2SO4 N S  2660 10.77 0.125 
Dolomite CaMg(CO3)2 CMC2 2840 10.87 0.124 
Periclase MgO M 3580 10.41 0.121 

 

          a cubic polymorph 
          b orthorhombic polymorph 
 
 
 
 
     Table 3. Textural and chemical characteristics useful for distinguishing cement phases. 
 

         Phase Identifying Characteristics 
Free Lime  Bright BE, rounded crystals, sometimes clustered, strong Ca and no Fe  
Ferrite  Bright BE, dendritic to prismatic matrix phase, high Ca, medium Fe and Al  
Alite  Medium-high BE, euhedral to anhedral crystals, framework grain, strong Ca and Si, minor Mg and Al 
Belite  Medium BE, rounded crystals, framework grain, sometimes clustered, strong Ca and Si, minor Mg, Al, 

and weak S  
Aluminate  Medium BE, fine to lath-like crystals, matrix phase between ferrite crystals, Ca, Al, Mg, K, Fe, and 

sometimes Na  
Arcanite  Medium BE, crystals dispersed along boundaries of matrix and framework grains, high K, S  
Aphthitalite  Low BE, crystals dispersed along boundaries of matrix and framework grains, high K, Na, S  
Syngenite  Low BE, K, S, Ca  
Anhydrite  Ca, S, individual grain, may occur as perimeter phase on gypsum  
Bassanite  Ca, S, individual grain, not typically resolvable from anhydrite or gypsum  
Calcite  Ca, no S, K, or Na, individual grain, dark BE  
Gypsum  Ca, S, no K, Na, individual grains  
Thenardite  Low BE, crystals dispersed, typically along boundaries of matrix and framework grains, high Na, S  
Dolomite  Ca, Mg, no Al or S, individual grain  
Periclase  Low BE, Mg, O, equant to dendritic grains, clustered to dispersed  
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should be reduced or eliminated to improve the phase distinction. For example, the Ca and Si XR image, or 
a ratio of the two, may be considered for distinguishing the calcium silicate phases. The BE image, 
however, provides a much better distinction between the calcium silicates and is preferred because XR 
images have lower resolution and therefore appear grainier and noisier than the BE image. Further details 
and examples of how SEM images may be combined to render these phases distinct will be discussed in a 
later section. 
 
 
3.3  X-Ray Microanalysis and Imaging 
 
      X-rays are produced as a result of the interaction of the electron beam with the specimen, and they are 
typically displayed as a set of peaks with a continuous background. The energy-dispersive X-ray analyzer 
discriminates and counts emitted X-rays based upon their energy. 
 
3.4  Image Processing 
 
      The next four sections briefly provide guidance for processing the experimentally obtained images and 
transforming them to a single phase segemented image suitable for quantitative stereological analysis. A 
more detailed procedure may be found in Stutzman et al. [20] 
      ImageJ6 is used to preview the SEM BE and XR images and to interactively make some adjustments to 
the background and noise by improving the image quality. The original images are always retained and the 
File → Save As command is used to save a modified image. Appending the filename with an M to indicate 
the operation performed on the image indicates that it has been modified. By appending the filename with 
an operation code, the images will appear together in the directory, allowing for easy viewing of the 
available images. A TIFF file format is always selected to eliminate any image quality loss with subsequent 
processing operations. 
 

1. Read images individually or by drag-and-drop with ImageJ. 
2. Tile images to arrange all on the monitor (Window → Tile)  
3. Assign a gray lookup table (LUT) to each image (Image → Lookup Table → Grays)  
4. Adjust each image’s brightness and contrast to assess the noise associated with low element 

concentration or the background (image noise): Image → Adjust → Brightness Contrast  
5. Subtract background noise with operation (Process → Subtract) using the preview check box in 

the Subtract operation window to interactively select the noise level. When acceptable, select OK.  
6. Clean up any noise by filtering. The Despeckle and the Remove Outliers commands under  

Process → Noise can be applied to remove isolated pixels or small pixel groups. The median filter 
(Process → Filters → Median) or the Thresholded Blur will also work well to reduce image noise 
while retaining edge details. Apply any filtering lightly as edge blur may result in problems during 
the segmentation phase. Save the modified image using File → Save As → TIFF, appending the 
original file name with an “M” to indicate this file has been modified, so that the original is not 
over-written.  

7. Use MultiSpec7 to generate a segmented, indexed image where each pixel is uniquely assigned to 
the class it most likely belongs based upon a user-developed training set of data. An abbreviated 
set of steps, which will be detailed below include (a) reading image files, (b) linking files, (c) 
designating phase classes, (d) establishing training fields for each class, (e) selecting a 
classification algorithm, (f) evaluating the classification, (g) saving the project, and (h) saving the 
classified image as an indexed, segmented TIFF file. This image file will then be used for the 
image analysis for determining phase area fraction, phase mass fraction, and phase perimeter 

                                                 
6 http://imagej.nih.gov/ij/ 
7 https://engineering.purdue.edu/ biehl/MultiSpec/ 
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fraction. The resulting image and phase-related data are useful characteristics of the microstructure 
and for introduction into simulation models like VCCTL [28, 29] or THAMES [30].  

8. In Multispec, read initial image as a multispectral type (File → Open Image), and check 
“multispectral type” box. Under “Multispectral Display Specifications” accept the defaults with 
the exception of the “Enhancement” section, where you can opt to not change the image (the 
usual), clip it on the low and high end, or user selected clipping.  

9. Link the set of X-ray images deemed useful in making a segmentation: File → Open Image. Note: 
This operation requires selecting “Link to active image window” from the drop-down box. 
Select the X-ray images by clicking on them individually. Remember to select the modified ones 
(M). Use a standard image sequence so that the exact image source in the virtual linked files (BEI, 
Al, Mg, K, Na, S) can easily be recalled or write it down. They can be named later if necessary 
and excluded in the classification if desired. Click on the Cancel button to complete the linking.  

10. Save the image set (Processor → Reformat → Rectify Image) 
Use the window defaults (one could attempt to correct any displaced images here if needed), make 
sure the path is correct and provide a name, retaining the .LAN extension. Use the original file 
name to keep them together in a listing. If you do not include the extension, the file will be written 
without one and will not be recognized for future Read operations.  

11. Open the .LAN image set for review, assigning classes and training fields, and classification    
(File → Open Image) 
A window labeled “Multispectral Display Specifications” will appear, where color channels        
(R G B) can be assigned and the images enhanced by clipping or transformation. At NIST, 
enhancements are performed using ImageJ because Multispec seems to apply a single set of 
operations to each image. View the image using different channel/color combinations. The most 
useful are:   

• BE, Mg, Al — alite, belite, aluminate, ferrite, periclase, lime, calcite, dolomite, voids  
• BE, K, S — alkali sulfates, calcium sulfates  

12. Establish training classes (Processor → Statistics) 
Accept the defaults in the “Set Project Options” window by clicking OK. 
In the new Project window you will see a Class Designation at the top. Enter the list of classes 
here by boxing in a region in the image for each, selecting “Add to List” and providing a name. 
The classes are listed based on this sequence and the ultimate index value used for VCCTL or 
THAMES, following this convention: 
 
     1 = alite  2 = belite        3 = aluminate        4 = ferrite 
     5 = periclase  6 = arcanite        7 = aphthitalite        8 = void 
 
Record the index designations for later use as some phases will be absent from some materials. 
Subclasses can be created—for example, alkali sulfate could contain sub-classes arcanite 
(potassium sulfate) and aphthitalite (potassium, sodium sulfate). 
Add training classes then by selecting the class, boxing in more regions, and specifying “Add to 
List”. The more training pixels, the better the class characteristics are defined. 

13. Classify (Processor →Classify) 
Specify the “Minimum Euclidian Distance” algorithm as it works consistently well. Check the box 
“Write Classification Results” to Disk File and check the path, retaining the .GIS extension for 
this image. 
Initial quality check is the percent re-assignment of the training set pixels and the quality of the 
class assignment seen in the .GIS image. The .GIS image is read into Multispec as a Multispectral 
type image and you will see the class assignments with distinct colors. The colors may be changed 
by double clicking on the class list followed by setting the color using the color picker. 

14. Save the work as a Project 
Even if not successful, you can go back and add training fields, delete fields, run alternate 
classification algorithms, and even exclude specific images to see if it can be improved. 
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15. Save the .GIS file as a TIFF file. 
This preserves the color assignments for the phases and the index values. Do not save these in the 
.JPG format as the index values and colors will not be saved. A good practice is to append the file 
name with a MS suffix, to avoid overwriting the previous files. 

16. Clean up any mis-assigned pixels using a surface blur filter that retains edge details. 
The plugin “Thresholded Blur” works well for this by ignoring pixels that deviate from the mean 
and by allowing you to specify the kernel size (radius, start with 2 or 3), threshold (1 or 2 as this is 
an indexed image and the values differ by 1), softness (affects the edge blur) and strength (number 
of times to apply). 

17. Read the TIFF file into ImageJ and write the ASCII Indexed file (File → Save As → Text Image). 
 
This procedure produces an ASCII file with the phase index values. If needed, you can recall the .GIS file 
in Multispec or the *MS.TIF file in ImageJ to see which index value corresponds to each phase. 
 
3.5  Quantitative Image Analysis 
 
      The final result of phase segmentation is a 2D color image that identifies each pixel with an integer 
index associated with its assigned phase. Quantitative analysis can be performed on such an image to 
calculate, for example  

1. the area fraction of each phase (on a total solids basis)  
2. the perimeter fraction of each phase (on a total solid boundary length basis)  
3. the spatial distribution of each phase, quantified, for example, by 2-point correlation functions  
4. the possible percolation, or connectivity, of each phase in two dimensions  

 
Many, if not all, of these operations can be performed by built-in functions, such as generating a histogram 
and list from the indexed image or augmenting ImageJ with Java plugins such as the correlation function. 
However, most of these plugins have been developed and optimized for image processing in other fields, 
especially biology, and are not well-documented or validated for use with clinker or cement microstructure 
images. As an alternative, NIST has developed a simple, fast computer program specifically for performing 
quantitative image analysis on clinker or cement microstructures. The program, called MicroChar [31], is 
available for Windows or Mac OS X computers, and performs all these calculations with minimal 
intervention by the user. Installation and use of MicroChar is described in Ref. [31]. 
 
 
4.  Applications to Portland Cement Powders 
 
      This section demonstrates the use of the foregoing procedures to analyze three portland cement 
powders, which are designated as 3-70, 3-71, and 3-74.8 Each of these cements was analyzed by XRD, both 
with and without selective chemical extractions, and by SEM/XMA. 
 
4.1  X-ray Diffraction Results 
 
      X-ray powder diffraction analyses include triplicate scans of each sample treatment (bulk cement, 
KOSH residue, SAM residue) with sample re-packing for each scan. The replication provides multiple 
estimates of the phase composition for both the individual treatments and the averaged cement 
composition. A representative set of diffraction data for the three cements are shown in Fig. 6, Fig. 7, and 
Fig. 8. An initial comparison of the peak intensities between cements provides some insights on their 
relative compositions. The effects of concentrating specific phase groups is seen by the increased peak 
intensities in the extraction residue patterns as well as the improved clarity of the simpler residue mixtures. 
 
 
                                                 
8 These designations reflect an internal material logging convention at NIST and have no other significance. 
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Fig. 6. X-ray powder diffraction patterns for cement 3-70 with phase identifications, with bulk cement (black), KOSH/sugar residue 
(blue), and SAM residue (red). 
 

 
 
Fig. 7. X-ray powder diffraction patterns for cement 3-71 with phase identifications, with bulk cement (black), KOSH/sugar residue 
(blue), and SAM residue (red). 
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Fig. 8. X-ray powder diffraction patterns for cement 3-74 with phase identifications, with bulk cement (black), KOSH/sugar residue 
(blue), and SAM residue (red). 
 
 
      For example, cements 3-70 and 3-74 have relatively high aluminate content and relatively low ferrite 
content compared to cement 3-71, looking at the diffraction peaks for these phases in the 32° 2-θ to 36° 2-θ 
region. A diffraction peak shows up in the SAM extraction residue for cements 3-70 and 3-74. Syngenite 
may form from a reaction between gypsum and one of the forms of potassium sulfate during storage of a 
cement [32]. It also may form during the selective extraction process or during the filtration of the insoluble 
residue. Checking the bulk diffraction pattern in these cases suggests that it may be isolated to the SAM 
extraction, and may be the result of a reaction during this process. Similarly, the presence of a broad 
diffraction peak around 18° 2-θ, corresponding to portlandite, is detected from the KOSH residue. 
Portlandite likely forms during the KOSH extraction procedure itself, which can often be very slow to filter 
and thereby can alter the phase composition during the final water wash step. For this reason, the KOSH 
residue quantitative results were not used in the averaging for the overall compositional estimates. 
Nevertheless, the KOSH extraction residue is useful for examining the silicate phases, including the 
potential presence of the alpha form of belite. 
      The SAM extraction residue is particularly helpful as it facilitates phase identifications through 
concentration of the non-silicate fraction, eliminating the diffraction peak interferences from the silicate 
phases. Some phases are concentrated by the process, such as the alkali sulfates, which are typically present 
in low concentrations and otherwise difficult to clearly identify from the bulk cement analysis. This 
concentration is also helpful in the identification of the calcium sulfate forms, which can affect the 
hydration characteristics of a cement. 
      After the qualitative phase identifications, the quantitative results were totaled in two ways: 1) for the 
extraction residue and 2) recalculated on a whole-cement basis, taking into account the insoluble residue 
mass as a fraction of the bulk cement. While the phase estimates across sample treatments are generally 
consistent, alkali sulfate values between the bulk cement and the SAM residue were not. Therefore, the 
alkali sulfate phase concentration estimates were based only on the SAM residue because they are 
relatively more concentrated in that residue and less likely to suffer interference from peak overlap. 
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Estimates of other phases, such as aluminates, ferrite, periclase, calcium sulfates, and calcium carbonates, 
represent an averaged value across the six replicates of the two treatments. 
 
4.2  Microstructure Characterization 
 
4.2.1  Backscattered Electron and X-Ray Images 
 
        A representative image field for cement 3-70 is shown in Fig. 9. This image set was collected at 
1200× magnification using a 1024 pixel × 768 pixel image, producing a spatial resolution of 2 µm per 
pixel. This is in excess of that used for routine imaging and was done here to better illustrate the phases. 
These images were collected simultaneously so they are registered, with the same pixels on each image 
representing the same region. The brightness is proportional to X-ray counts, and roughly proportional to 
element concentration. The accompanying color stacks in the figure illustrate the ways in which different 
phases can be clearly identified. For example, arcanite (K S ) contains only potassium and sulfur, so if the 
potassium X-ray map is assigned to the green channel and the sulfur X-ray map is assigned to the yellow 
channel, pixels belonging to arcanite will be white (see Fig. 9(c)) because green and yellow are 
complementary colors and arcanite, which has a relatively low backscatter coefficient, contributes 
relatively little to the red BE channel. Similarly, periclase (MgO) can be identified as bright green domains 
by assigning Mg to the green channel, as in Fig. 9(b), because periclase, with low backscatter coefficient, 
appears dark in BE images. The Al-rich regions shown as dark blue in Fig. 9(b) likely indicate a small 
quantity of a glassy aluminosilicate slag phase. 
 
4.2.2  Quantitative Analysis 
 
      The software application MicroChar [31] was used to analyze the indexed image fields produced by the 
segmentation procedures described in Sec. 3.4. Representative phase-segemented images of the three 
cements are shown in Figs. 10 through 12, and Tables 4 through 6 show the calculated mean mass percent 
to be consistent with the XRD results and perimeter percentages of each phase on a total mass and total 
perimeter basis, respectively. The perimeter percentages illustrate the utility of imaging with the ability to 
estimate the surface area of the constituent phases. These data may be useful in developing understandings 
of early-age cement performance given the knowledge of the surface area of each phase initially exposed to 
the mixing water. The means and uncertainties (1s) were calculated from four to seven segmented images 
of each cement. A standard error of the mean /s n  along with upper- and lower-confidence limits may be 
calculated from these data if necessary. 
 
4.3  Method Comparisons for Phase Abundance 
 
      Tables 7 through 9 summarize and compare the quantitative phase analysis by both methods for each 
cement. In the tables, the column labeled “XRD” displays the XRD-based mean mass fraction and the 
standard deviation (s) based on three to five replicate measurements each of the bulk cement and SAM 
extraction. The values measured for the SAM extraction were renormalized to the original mass of the bulk 
cement powder. Similarly, the column labeled “SEM/XMA” displays the same information obtained by 
microstructure analysis, using specific gravities to correct from volume to mass fractions. 
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Fig. 9. (a) SEM backscattered electron (BE) image of cement 3-70; (b) color stack of BE image (red channel), Mg distribution (green 
channel), and Al distribution (blue channel), in which interstial phases C3A and C4AF appear as purple, silicates as red, and periclase 
as green; (c) color stack of BE image (red channel), Na distribution (green channel), K distribution (blue channel), and S distribution 
(yellow) channel, in which calcium sulfate carriers and arcanite are visible as yellow and white domains, respectively. Field width is 
256 µm. 
 
 

http://dx.doi.org/10.6028/jres.121.004
http://dx.doi.org/10.6028/jres.121.004


 Volume 121 (2016) http://dx.doi.org/10.6028/jres.121.004 
 Journal of Research of the National Institute of Standards and Technology 
 
 
 

 67 http://dx.doi.org/10.6028/jres.121.004 

 

 
 

 
 
Fig. 10. Final phase-segmented micrograph (top) and original backscattered electron micrograph (bottom) for cement 3-70. Field 
width is 256 µm in each image. 
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Fig. 11. Final phase-segmented micrograph (top) and original backscattered electron micrograph (bottom) for cement 3-71. Field 
width is 256 µm in each image. 
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Fig. 12. Final phase-segmented micrograph (top) and original backscattered electron micrograph (bottom) for cement 3-74. Field 
width is 256 µm in each image. 
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Table 4. Mean mass and perimeter mass percent of each phase detected by SEM/XMA in cement 3-70, expressed as percentages of 
total mass. Variability is reported as one standard deviation (s) based on six image fields. 
 

   Phase           Mass Percent      Perimeter Percent 
  n Mean    s  Mean    s  
   Alite   6   54.9   1.5   39.8   0.9  
   Belite   6   14.0   1.1   17.5   1.0  
   Aluminatea   6   10.8   0.7   11.8   0.5  
   Ferrite   6   6.3   1.6   4.0   1.0  
   Periclase   6   2.3   0.3   2.3   0.6  
   Alkali Sulfateb   6   1.4   0.2   2.7   0.5  
   Gypsumc   6   5.7   1.2   8.4   1.0  
   Calcite   6   1.7   0.5   2.3   0.6  
   Dolomite   6   1.3   0.9   1.5   0.4  
   Slag   6   1.7   0.3   9.7   2.7  

 
        a Cubic and orthorhombic polymorphs are grouped together. 
        b All alkali sulfates (arcanite, thenardite, etc.) are grouped together. 
        c All forms of calcium sulfate (gypsum, bassanite, anhydrite) are grouped together. 

 
 
 
Table 5. Mean mass percents and perimeter fractions of each phase detected by SEM/XMA in cement 3-71, expressed as percentages 
of total mass and total perimeter, respectively. Variability is reported as one standard deviation (s) based on five image fields. 
 

   Phase            Mass Percent       Perimeter Percent  
  n  Mean    s  Mean    s 
   Alite   5   56.0   1.0   41.6   2.1  
   Belite   5   17.5   1.9   18.7   1.0  
   Aluminatea   5   5.6   0.3   8.2   0.6  
   Ferrite   5   7.1   0.4   5.6   0.1  
   Periclase   5   5.1   1.7   4.6   1.8  
   Alkali Sulfateb   5   0.9   0.1   2.1   0.1  
   Gypsumc   5   2.5   0.2   4.5   0.4  
   Calcite   5   2.6   0.8   3.1   0.5  
   Dolomite   5   0.5   0.7   0.6   0.6  
   Silica   5   0.9   0.7   4.9   4.7  
   Slag   5   0.8   0.8   6.2   5.7  

 
        a Cubic and orthorhombic polymorphs are grouped together. 
        b All alkali sulfates (arcanite, thenardite, etc.) are grouped together. 
        c All forms of calcium sulfate (gypsum, bassanite, anhydrite) are grouped together. 

 
 
 
Table 6. Mean mass percents and perimeter fractions of each phase detected by SEM/XMA in cement 3-74, expressed as percentages 
of total mass and total perimeter, respectively. Variability is reported as one standard deviation (s) based on six image fields. 
 

   Phase            Mass Percent       Perimeter Percent  
  n  Mean    s Mean    s 
   Alite   6   57.9   2.3   43.6   1.6  
   Belite   6   12.2   1.9   16.3   1.1  
   Aluminatea   7   9.0   1.6   10.5   3.3  
   Ferrite   6   9.1   1.3   6.1   1.0  
   Periclase   6   1.5   0.4   1.6   3.5  
   Alkali Sulfateb   6   1.7   0.3   3.5   0.5  
   Gypsumc   6   3.6   0.3   6.3   0.6  
   Calcite   6   1.1   0.4   1.5   0.5  
   Dolomite   6   1.9   1.1   1.7   0.3  
   Silica   6   0.6   0.4   3.4   3.3  
   Slag   6   1.2   0.4   5.8   4.4  

 
        a Cubic and orthorhombic polymorphs are grouped together. 
        b All alkali sulfates (arcanite, thenardite, etc.) are grouped together. 
        c All forms of calcium sulfate (gypsum, bassanite, anhydrite) are grouped together. 
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Table 7. Mean mass fractions, expressed as percentages of cement mineral phases obtained for cement 3-70 by XRD and SEM/XMA, 
and with uncertainties reported as one standard deviation (s). 
 

   Phase                            XRD                     SEM/XMA  
  n  Mean   s  n  Mean    s 
   Alite   3   53.5   0.3   6   54.9   1.5  
   Belite   3   14.9   0.1   6   14.0   1.1  
   Aluminate-ca   6   5.3   0.3   6   10.8a   0.7  
   Aluminate-ob   6   4.5   0.7   6      
   Ferrite   6   8.0   0.3   6   6.3   0.6  
   Periclase   6   1.7   0.2   6   2.3   0.3  
   Arcanite   6   0.1   0.1   6   1.4c   0.2  
   Aphthitalite   6   0.3   0.0   6      
   Syngenite   6   1.7   0.0   6      
   Gypsum   6   3.3   0.1   6   5.7c   1.2  
   Bassanite   6   1.9   0.8   6      
   Calcite   6   2.1   0.2   6   1.7   0.5  
   Quartz   6   0.5   0.2   6   0.0   0.0  
   Dolomite   6   2.2   0.2   6   1.3   0.9  

 
               a Cubic polymorph; SEM/XMA groups both cubic and orthorhombic polymorphs together. 
               b Orthorhombic polymorph. 
               c SEM/XMA groups all alkali sulfates together and groups all calcium sulfates together. 
 
 
 
 
 
Table 8. Mean mass fractions, expressed as percentages of cement mineral phases obtained for cement 3-71 by XRD and SEM/XMA, 
and with uncertainties reported as one standard deviation (s). 
 

   Phase                            XRD                     SEM/XMA  
  n  Mean    s  n  Mean    s 
   Alite   3   58.4   0.7   5   56.0   1.0  
   Belite   3   15.0   0.9   5   17.5   1.9  
   Aluminate-ca   6   1.6   0.2   5   5.6a   0.3  
   Aluminate-ob   6   2.2   0.3   5      
   Ferrite   6   10.7   0.9   5   7.5   0.4  
   Periclase   6   3.4   0.3   5   5.1   1.7  
   Arcanite   6   0.3   0.1   5   0.9c   0.1  
   Aphthitalite   6   0.1   0.1   5      
   Gypsum   6   1.5   0.1   5   2.5c   0.2  
   Bassanite   6   1.7   0.2   5      
   Calcite   6   3.3   0.5   5   2.6   0.8  
   Quartz   6   0.2   0.0   5   0.9   0.7  
   Dolomite   6   1.1   0.2   5   0.5   0.7  

 
               a Cubic polymorph; SEM/XMA groups both cubic and orthorhombic polymorphs together. 
               b Orthorhombic polymorph. 
               c SEM/XMA groups all alkali sulfates together and groups all calcium sulfates together. 
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Table 9. Mean mass fractions, expressed as percentages of cement mineral phases obtained for cement 3-74 by XRD and SEM/XMA, 
and with uncertainties reported as one standard deviation (s). 
 

   Phase                            XRD                     SEM/XMA  
  n  Mean    s  n  Mean    s 
   Alite   3   58.9   2.8   6   57.9   2.5  
   Belitea   3   10.8   1.3   6   12.2   2.1  
   Aluminate-cb   6   5.5   0.2   6   9.0a   1.8  
   Aluminate-oc   6   3.7   0.2   6      
   Ferrite   6   9.2   0.7   6   9.1   1.5  
   Periclase   6   1.6   0.2   6   1.5   0.5  
   Syngenite   3   1.4   0.4   6   1.7d   0.3  
   Aphthitalite   6   0.4   0.3   6      
   Gypsum   6   3.5   0.5   6   3.6d   0.3  
   Bassanite   6   0.9   0.5   6      
   Calcite   6   1.4   0.4   6   1.1   0.5  
   Quartz   6   0.5   0.2   6   0.6   0.4  
   Dolomite   6   1.9   0.2   6   1.9   1.2  

 
               a SEM/XMA groups both α and β polymorphs of C2S together. 
               b Cubic polymorph; SEM/XMA groups both cubic and orthorhombic polymorphs together. 
               c Orthorhombic polymorph. 
               d SEM/XMA groups all alkali sulfates together and groups all calcium sulfates together. 
 
 
      The comparison between methods may be more easily grasped by plotting the SEM/XMA mass 
fractions against the XRD mass fractions, as shown in Figs. 13 through 15. For each cement in these plots, 
the data fall near the dashed line of equality, especially when the uncertainty of both methods is taken into 
account, as shown by the horizontal and vertical error bars. Outlying points, which do not touch the line of 
equality even when including the uncertainty, tend to correspond to phases having very small mass 
fractions, which are more difficult to detect by either technique. 
 

 
 
Fig. 13. Comparison of phase abundance in cement 3-70 as measured by SEM/XMA and by XRD. All values are reported as mass 
percentages on a total solids basis. Error bars represent plus or minus one sample standard deviation as reported in Table 7. 
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Fig. 14. Comparison of phase abundance in cement 3-71 as measured by SEM/XMA and by XRD. All values are reported as mass 
percentages on a total solids basis. Error bars represent plus or minus one sample standard deviation as reported in Table 8. 
 
 

 
 
Fig. 15. Comparison of phase abundance in cement 3-74 as measured by SEM/XMA and by XRD. All values are reported as mass 
percentages on a total solids basis. Error bars represent plus or minus one sample standard deviation as reported in Table 9. 
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4.4  Consensus Means 
 
      The techniques and results provided in this paper potentially can be used to produce the kinds of 
reference materials that standards committees need for developing standard test methods for composition. 
Reference materials are generally developed using a consensus from multiple, unique measurement 
methods. As already described in Sec. 1, each method here has strengths and weaknesses. The XRD 
method can distinguish polymorphs (cubic and orthorhombic tricalcium aluminate, different calcium 
sulfate forms such as anhydrite, bassanite, gypsum). The SEM/XMA method can reveal phase texture and 
phases with small volume occurrence, but can not always make a distinction between polymorphs or the 
sulfate forms. The goal here is to reconcile the data sets to produce consensus values useful for the cement 
industry to use in testing and development of quantitative methods for cement phase characterization. The 
computation of consensus means can be accomplished by using the within-method and between-method 
variances to determine the confidence in, or weighting of, the average mass fraction for a given phase 
obtained by SEM/XMA relative to XRD. The consensus mean mass fraction of each phase is the weighted 
average of the values obtained by each method. In addition, the statistical method calculates the standard 
uncertainty in the consensus mean values. 
      Several approaches may be applied to compute consensus means and associated uncertainties based 
upon results from multiple methods [33]. Here, a consensus method has been chosen that does not weight 
the result based upon a method’s precision or the number of replicate determinations. The intent of using 
multiple methods is to quantify and include in the overall estimate of uncertainty the systematic biases of 
the individual methods by using the variation across the methods results. 
      Two common, but simple, models for estimating a consensus mean and uncertainty are considered first 
[34]. The Grand Mean is the simplest model that assumes no method effect, and is simply the mean of all 
the data with a standard t-based confidence interval: 
 

     (1 /2, 1)
GM

nt s
x

n
α− −±      (2) 

 
where GMx  is the Grand Mean, t is the t-value for a given combination of confidence interval, α, and 
number of samples, n, and s is the sample standard deviation. In the measurements reported here, the 
inherently less precise SEM/XMA results have three times the sampling of the XRD measurements. 
Therefore, the Grand Mean is not the best model, but is merely a starting point. 
      A second model is the Mean of Means, where a mean and standard deviation are determined separately 
for each method, and then a mean of those means is calculated along with a confidence interval:  
 

                    ( )1 /2, 1
MM

mt s
x

m
α− −±     (3) 

 
where MMx  is the Mean of Means and m is the number of methods used, which is two in this case. This 
weights the methods equally but does not account for either differences in sample size or within-method 
variation. 
      The third method—and the one selected in this report of example consensus values of the composition 
of each of the three cements— takes unweighted averages of mean values obtained by XRD and 
SEM/XMA using the Type B on Bias (BOB) approach [35, 36]. The method is designed to handle cases 
where the number of analytical methods is small (two to five), and the ordinary sample standard deviation 
is an inadequate estimate of the uncertainty of the systematic effects [37]. The method combines a pooled 
estimate of within-method uncertainty with a between-method error estimate in quadrature, and multiplies 
by an expansion factor of k = 2. The between-method standard error estimate is derived by assuming that 
different source/method/lab mean estimates distribute uniformly, and then computing a (“between-
method”) standard error as the standard deviation of the underlying uniform distribution of source means, 
as (max(mean)-min(mean))/ 12 . 
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      Tables 10, 11, and 12 show the consensus mean mass fractions of each phase, as a percentage of total 
solid mass, in cements 3-70, 3-71, and 3-74, respectively. The tables also report the standard uncertainty 
(i.e., the estimated standard deviation) and the expanded uncertainty (i.e., twice the estimated standard 
deviation) in the mean values, which for each phase are quite small compared to the mean value. The 
graphics and statistical analysis code DATAPLOT [33] was used for the consensus calculations found in 
Tables 10, 11, and 12. A summary of the Dataplot consensus output may be found the appendix. 
 
 
Table 10. Mass fraction summary statistics by consensus method for cement 3-70. 
 

Phase Consensus 
Mean (%) 

Within 
Method 

Uncertainty (%) 

Between 
Method 

Uncertainty (%) 

Standard 
Uncertainty (%) 

k = 1 

Expanded 
Uncertainty (%) 

k = 2 
Alite 54.18 0.32 0.39 0.51 1.02 
Belite 14.41 0.23 0.26 0.34 0.69 

Aluminate 10.32 0.15 0.29 0.33 0.67 
Ferrite 7.13 0.32 0.51 0.60 1.20 

Periclase 1.99 0.07 0.19 0.20 0.40 
Alkali Sulfates 1.70 0.05 0.16 0.17 0.33 

Gypsum 5.54 0.25 0.13 0.28 0.56 
Calcite 1.83 0.10 0.06 0.12 0.24 

Dolomite 1.66 0.18 0.23 0.29 0.59 
 
 
 
Table 11. Mass fraction summary statistics by consensus method for cement 3-71. 
  

Phase Consensus 
Mean (%) 

Within 
Method 

Uncertainty (%) 

Between 
Method 

Uncertainty (%) 

Standard 
Uncertainty (%) 

k = 1 

Expanded 
Uncertainty (%) 

k = 2 
Alite 57.17 0.32 0.69 0.76 1.53 
Belite 16.26 0.49 0.71 0.86 1.72 

Aluminate 4.70 0.06 0.52 0.52 1.05 
Ferrite 9.12 0.10 0.91 0.92 1.84 

Periclase 4.25 0.39 0.47 0.61 1.21 
Alkali Sulfates 0.49 0.09 0.17 0.19 0.38 

Gypsum 2.81 0.04 0.20 0.20 0.40 
Calcite 2.93 0.19 0.20 0.27 0.55 

Dolomite 0.81 0.15 0.16 0.22 0.44 
Quartz 0.54 0.15 0.12 0.25 0.49 

 
 
 
Table 12. Mass fraction summary statistics by consensus method for cement 3-74. 
 

Phase Consensus 
Mean (%) 

Within 
Method 

Uncertainty (%) 

Between 
Method 

Uncertainty (%) 

Standard 
Uncertainty (%) 

k = 1 

Expanded 
Uncertainty (%) 

k = 2 
Alite 58.41 0.55 0.31 0.63 1.26 
Belite 11.50 0.49 0.41 0.64 1.27 

Aluminate 9.11 0.36 0.05 0.36 0.73 
Ferrite 9.13 0.30 0.03 0.30 0.60 

Periclase 1.55 0.09 0.01 0.09 0.19 
Alkali Sulfates 1.76 0.06 0.05 0.08 0.16 

Gypsum 4.00 0.07 0.24 0.25 0.51 
Calcite 1.34 0.10 0.03 0.11 0.21 

Dolomite 1.89 0.25 0.01 0.25 0.49 
Quartz 0.43 0.08 0.01 0.08 0.16 
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5.  Summary 
 
      XRD and SEM/XMA are complementary characterization methods, each of which has distinct strengths 
and weaknesses for quantifying the phase composition of multicomponent materials such as portland 
cement. XRD is a bulk technique that can potentially quantify each phase, including polymorphs of the 
same composition, based on crystal structure models. Specimen preparation is relatively easy compared to 
SEM/XMA, and the results are more precise than SEM/XMA and are representative of the bulk material. 
Interpretation of XRD patterns is complicated by potential peak overlap among multiple phases, but 
selective mineral extractions can reduce the uncertainty caused by peak overlap. Furthermore, XRD is 
unable to assess the nature and composition of any amorphous phases that may be present in the material. 
SEM/XMA can assess the spatial distribution of phases within the microstructure and does not suffer the 
uncertainty in phase identification caused by XRD peak overlap. However, specimen preparation is 
relatively more complicated for SEM/XMA and, in addition, the technique is unable to distinguish phases 
that are compositionally very similar, such as different hydrated forms of calcium sulfate or mineral 
polymorphs. Furthermore, SEM/XMA can have lower precision than XRD because of the small sample 
volumes that are investigated. Therefore, several image fields must be analyzed, depending on the 
magnification and pixel resolution, to obtain good estimates of phase abundance. Sampling errors also can 
be reduced by using automated stage motion to obtain any number of partially overlapping images that 
subsequently can be stitched together to obtain a much larger single image field upon which the analysis 
can be conducted. 
      This study has demonstrated how XRD and SEM/XMA can be used together to obtain a better picture 
of portland cement phase composition than either method alone can provide. The focus has been on 
describing the methods in sufficient detail so that others can reproduce them in their own laboratories. In 
addition, the methods have been applied to characterize three portland cement powders. Results from the 
two methods are consistent, which promotes higher confidence in the results. But beyond that, the Type B 
on Bias method for calculating consensus means and associated uncertainty estimates provides a 
quantitative way to account for the different precisions and sampling rates of the two methods so that they 
can be weighted appropriately in determining the consensus values for each phase. 
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6.  Appendix A. Consensus Phase Mass Percentage Analysis for Cement 3-70 
 
A.1  Alite 
 
Summary 
 

Number of Observations:            9  
Grand Mean:  54.4056  

Grand Standard Deviation:  1.3918  
Total Number of Methods:            2  

Mean of Method Means:  54.1783  
SD of Method Means:  0.9640  

SD of Method Means (wrt to grand mean):  1.0162  
Within Method (pooled) SD:  1.2972  

Within Method (pooled) Variance:  1.6828  
   

Method: BOB (Bound on Bias)   
Estimate of Consensus Mean:  54.1783  

Within Method Uncertainty:  0.3205  
Between Method Uncertainty:  0.3936  
Standard Uncertainty (k = 1):  0.5075  

Expanded Uncertainty (k = 2):  1.0151  
Lower 95 % (k = 2) Confidence Limit:  53.1633  
Upper 95 % (k = 2) Confidence Limit:  55.1934  

 
 
 
Results by method 
 

 
Method 

ID 

 
 

n(i)  

 
 

Mean 

 
 

Variance 

 
Standard 
Deviation 

Standard 
Deviation 

of the Mean 
XRD 3 53.4967 0.0680 0.2608 0.1506 
SEM 6 54.8600 2.3286 1.5260 0.6230 
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A.2  Belite 
 
Summary 
 

Number of Observations:            9  
Grand Mean:  14.2589  

Grand Standard Deviation:  0.9792  
Total Number of Methods:            2  

Mean of Method Means:  14.4108  
SD of Method Means:  0.6446  

SD of Method Means (wrt to grand mean):  0.6795  
Within Method (pooled) SD:  0.9265  

Within Method (pooled) Variance:  0.8583  
   

Method: BOB (Bound on Bias)    
Estimate of Consensus Mean:  14.4108  

Within Method Uncertainty:  0.2252  
Between Method Uncertainty:   0.2632  

Standard Uncertainty (k =1):  0.3464  
Expanded Uncertainty (k =2):  0.6927  

Lower 95 % (k =2) Confidence Limit:  13.7181  
Upper 95 % (k =2) Confidence Limit:   15.1035  

 
 
 
Results by method 
 

 
Method 

ID 

 
 

n(i) 

 
 

Mean 

 
 

Variance 

 
Standard 
Deviation 

Standard 
Deviation 

of the Mean 
XRD 3 14.8667 0.0094 0.0971 0.0561 
SEM 6 13.9550 1.1979 1.0945 0.4468 
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A.3  Tricalcium aluminate 
 
Summary 
 

Number of Observations:            9  
Grand Mean:  10.4944  

Grand Standard Deviation:  0.7769  
Total Number of Methods:            2  

Mean of Method Means:  10.3242  
SD of Method Means:  0.7224  

SD of Method Means (wrt to grand mean):  0.7615  
Within Method (pooled) SD:  0.6257  

Within Method (pooled) Variance:  0.3915  
   

Method: BOB (Bound on Bias)    
Estimate of Consensus Mean:  10.3242  

Within Method Uncertainty:  0.1543  
Between Method Uncertainty:   0.2949  
Standard Uncertainty (k = 1):  0.3329  

Expanded Uncertainty (k = 2):  0.6657  
Lower 95 % (k = 2) Confidence Limit:  9.6584  
Upper 95 % (k = 2) Confidence Limit:   10.9899  

 
 
 
Results by method 
 

 
Method 

ID 

 
 
( )n i  

 
 

Mean 

 
 

Variance 

 
Standard 
Deviation 

Standard 
Deviation 

of the Mean 
XRD 3    9.8133 0.0146 0.1210 0.0698 
SEM 6 10.8350 0.5423 0.7364 0.3006 
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A.4  Tetracalcium aluminoferrite 
 
Summary 
 

Number of Observations:            9  
Grand Mean:  6.8389  

Grand Standard Deviation:  1.5215  
Total Number of Methods:            2  

Mean of Method Means:  7.1325  
SD of Method Means:  1.2457  

SD of Method Means (wrt to grand mean):  1.3131  
Within Method (pooled) SD:  1.3262  

Within Method (pooled) Variance:  1.7589  
   

Method: BOB (Bound on Bias)    
Estimate of Consensus Mean:  7.1325  

Within Method Uncertainty:  0.3218  
Between Method Uncertainty:   0.5085  
Standard Uncertainty (k = 1):  0.6018  

Expanded Uncertainty (k = 2):  1.2036  
Lower 95 % (k = 2) Confidence Limit:  5.9289  
Upper 95 % (k = 2) Confidence Limit:   8.3361  

 
 
 
Results by method 
 

 
Method 

ID 

 
 
( )n i  

 
 

Mean 

 
 

Variance 

 
Standard 
Deviation 

Standard 
Deviation 

of the Mean 
XRD 3 8.0133 0.0140 0.1185 0.0684 
SEM 6 6.2517 2.4568 1.5674 0.6399 
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A.5  Periclase 
 
Summary 
 

Number of Observations:            9  
Grand Mean:  2.1011  

Grand Standard Deviation:  0.4197  
Total Number of Methods:            2  

Mean of Method Means:  1.9933  
SD of Method Means:  0.4573  

SD of Method Means (wrt to grand mean):  0.4820  
Within Method (pooled) SD:  0.2860  

Within Method (pooled) Variance:  0.0818  
   

Method: BOB (Bound on Bias)    
Estimate of Consensus Mean:  1.9933  

Within Method Uncertainty:  0.0692  
Between Method Uncertainty:   0.1867  
Standard Uncertainty (k = 1):  0.1991  

Expanded Uncertainty (k = 2):  0.3982  
Lower 95 % (k = 2) Confidence Limit:  1.5951  
Upper 95 % (k = 2) Confidence Limit:   2.3915  

 
 
 
Results by method 
 

 
Method 

ID 

 
 
( )n i  

 
 

Mean 

 
 

Variance 

 
Standard 
Deviation 

Standard 
Deviation 

of the Mean 
XRD 3 1.6700 0.0003 0.0173 0.0100 
SEM 6 2.3167 0.1144 0.3382 0.1381 
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A.6  Alkali sulfates 
 
Summary 
 

Number of Observations:            9  
Grand Mean:  1.6022  

Grand Standard Deviation:  0.3296  
Total Number of Methods:            2  

Mean of Method Means:  1.6950  
SD of Method Means:  0.3936  

SD of Method Means (wrt to grand mean):  0.4149  
Within Method (pooled) SD:  0.1887  

Within Method (pooled) Variance:  0.0356  
   

Method: BOB (Bound on Bias)    
Estimate of Consensus Mean:  1.6950  

Within Method Uncertainty:  0.0466  
Between Method Uncertainty:   0.1607  
Standard Uncertainty (k = 1):  0.1673  

Expanded Uncertainty (k = 2):  0.3346  
Lower 95 % (k = 2) Confidence Limit:  1.3604  
Upper 95 % (k = 2) Confidence Limit:   2.0296  

 
 
 
Results by method 
 

 
Method 

ID 

 
 
( )n i  

 
 

Mean 

 
 

Variance 

 
Standard 
Deviation 

Standard 
Deviation 

of the Mean 
XRD 3 1.9733 0.0014 0.0379 0.0219 
SEM 6 1.4167 0.0493 0.2220 0.0906 
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A.7  Gypsum 
 
Note: This analysis includes gypsum, bassanite, and anhydrite forms together.  
 
Summary 
 

Number of Observations:   9  
Grand Mean:   5.510000  

Grand Standard Deviation:   0.9862302  
Total Number of Labs:   2  

Minimum Lab Mean:   5.203333  
Maximum Lab Mean:   5.663333  

Minimum Lab SD:   0.07767453  
Maximum Lab SD:   1.212100  

Mean of Lab Means:   5.433333  
SD of Lab Means:   0.3252691  

SD of Lab Means (wrt to grand mean):   0.3428638  
Within Lab (pooled) SD:   1.025253  

Within Lab (pooled) Variance:   1.051143  
    

Method: BOB (Bound on Bias)     
Estimate of Consensus Mean:   5.433333  

Within Lab Uncertainty:   0.2484329  
Between Lab Uncertainty:    0.1327906  

Standard Uncertainty (k = 1):   0.2816953  
Expanded Uncertainty (k = 2):   0.5633905  

Lower 95 % (k = 2) Confidence Limit:   4.869943  
Upper 95 % (k = 2) Confidence Limit:    5.996724  

 
 
 
Results by method 
 

 
Method 

ID 

 
 
( )n i  

 
 

Mean 

 
 

Variance 

 
Standard 
Deviation 

Standard 
Deviation 

of the Mean 
XRD 3 5.203333 0.006033333 0.07767453 0.04484541 
SEM 6 5.663333       1.469187        1.212100        0.4948378 
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A.8  Calcite 
 
Summary 
 

Number of Observations:            9  
Grand Mean:  1.7944  

Grand Standard Deviation:  0.4055  
Total Number of Methods:            2  

Mean of Method Means:  1.8308  
SD of Method Means:  0.1544  

SD of Method Means (wrt to grand mean):  0.1627  
Within Method (pooled) SD:  0.4175  

Within Method (pooled) Variance:  0.1743  
   

Method: BOB (Bound on Bias)    
Estimate of Consensus Mean:  1.8308  

Within Method Uncertainty:  0.1009  
Between Method Uncertainty:   0.0630  
Standard Uncertainty (k = 1):  0.1190  

Expanded Uncertainty (k = 2):  0.2380  
Lower 95 % (k = 2) Confidence Limit:  1.5929  
Upper 95 % (k = 2) Confidence Limit:   2.0688  

 
 
 
Results by method 
 

 
Method 

ID 

 
 
( )n i  

 
 

Mean 

 
 

Variance 

 
Standard 
Deviation 

Standard 
Deviation 

of the Mean 
XRD 3 1.9400 0.0003 0.0173 0.0100 
SEM 6 1.7217 0.2439 0.4938 0.2016 
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A.9  Dolomite 
 
Summary 
 

Number of Observations:            9  
Grand Mean:  1.5211  

Grand Standard Deviation:  0.8049  
Total Number of Methods:            2  

Mean of Method Means:  1.6558  
SD of Method Means:  0.5716  

SD of Method Means (wrt to grand mean):  0.6025  
Within Method (pooled) SD:  0.7441  

Within Method (pooled) Variance:  0.5537  
   

Method: BOB (Bound on Bias)    
Estimate of Consensus Mean:  1.6558  

Within Method Uncertainty:  0.1804  
Between Method Uncertainty:   0.2333  
Standard Uncertainty (k = 1):  0.2949  

Expanded Uncertainty (k = 2):  0.5899  
Lower 95 % (k = 2) Confidence Limit:  1.0659  
Upper 95 % (k = 2) Confidence Limit:   2.2457  

 
 
 
Results by method 
 

 
Method 

ID 

 
 
( )n i  

 
 

Mean 

 
 

Variance 

 
Standard 
Deviation 

Standard 
Deviation 

of the Mean 
XRD 3 2.0600 0.0037 0.0608 0.0351 
SEM 6 1.2517 0.7737 0.8796 0.3591 
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7.  Appendix B. Consensus Phase Mass Percentage Values for Cement 3-71 
 
B.1  Alite 
 
Summary 
 

Number of Observations:            8  
Grand Mean:  56.8688  

Grand Standard Deviation:  1.5261  
Total Number of Methods:            2  

Minimum Method Mean:  55.9660  
Maximum Method Mean:  58.3733  

Minimum Method SD:  0.7396  
Maximum Method SD:  1.0419  

Mean of Method Means:  57.1697  
SD of Method Means:  1.7022  

SD of Method Means (wrt to grand mean):  1.7546  
Within Method (pooled) SD:  0.9518  

Within Method (pooled) Variance:  0.9060  
   

Method: BOB (Bound on Bias)    
Estimate of Consensus Mean:  57.1697  

Within Method Uncertainty:  0.3160  
Between Method Uncertainty:   0.6949  
Standard Uncertainty (k = 1):  0.7634  

Expanded Uncertainty (k = 2):  1.5268  
Lower 95 % (k = 2) Confidence Limit:  55.6428  
Upper 95 % (k = 2) Confidence Limit:   58.6965  

 
 
 
Results by method 
 

 
Method 

ID 

 
 
( )n i  

 
 

Mean 

 
 

Variance 

 
Standard 
Deviation 

Standard 
Deviation 

of the Mean 
XRD 3 58.3733 0.5470 0.7396 0.4270 
SEM 5 55.9660 1.0855 1.0419 0.4659 
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B.2  Belite 
 
Summary 
 

Number of Observations:            8  
Grand Mean:  16.5613  

Grand Standard Deviation:  1.9688  
Total Number of Methods:            2  

Minimum Method Mean:  15.0333  
Maximum Method Mean:  17.4780  

Minimum Method SD:  0.8752  
Maximum Method SD:  1.8971  

Mean of Method Means:  16.2557  
SD of Method Means:  1.7286  

SD of Method Means (wrt to grand mean):  1.7818  
Within Method (pooled) SD:  1.6293  

Within Method (pooled) Variance:  2.6546  
   

Method: BOB (Bound on Bias)    
Estimate of Consensus Mean:  16.2557  

Within Method Uncertainty:  0.4937  
Between Method Uncertainty:   0.7057  
Standard Uncertainty (k = 1):  0.8613  

Expanded Uncertainty (k = 2):  1.7226  
Lower 95 % (k = 2) Confidence Limit:  14.5331  
Upper 95 % (k = 2) Confidence Limit:   17.9782  

 
 
 
Results by method 
 

 
Method 

ID 

 
 
( )n i  

 
 

Mean 

 
 

Variance 

 
Standard 
Deviation 

Standard 
Deviation 

of the Mean 
XRD 3 15.0333 0.7660 0.8752 0.5053 
SEM 5 17.4780 3.5989 1.8971 0.8484 
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B.3  Tricalcium aluminate 
 
Summary 
 

Number of Observations:            8  
Grand Mean:  4.9212  

Grand Standard Deviation:  0.9551  
Total Number of Methods:            2  

Minimum Method Mean:  3.7967  
Maximum Method Mean:  5.5960  

Minimum Method SD:  0.0503  
Maximum Method SD:  0.2785  

Mean of Method Means:  4.6963  
SD of Method Means:  1.2723  

SD of Method Means (wrt to grand mean):  1.3115  
Within Method (pooled) SD:  0.2293  

Within Method (pooled) Variance:  0.0526  
   

Method: BOB (Bound on Bias)    
Estimate of Consensus Mean:  4.6963  

Within Method Uncertainty:  0.0640  
Between Method Uncertainty:   0.5194  
Standard Uncertainty (k = 1):  0.5233  

Expanded Uncertainty (k = 2):  1.0467  
Lower 95 % (k = 2) Confidence Limit:  3.6496  
Upper 95 % (k = 2) Confidence Limit:   5.7430  

 
 
 
Results by method 
 

 
Method 

ID 

 
 
( )n i  

 
 

Mean 

 
 

Variance 

 
Standard 
Deviation 

Standard 
Deviation 

of the Mean 
XRD 3 3.7967 0.0025 0.0503 0.0291 
SEM 5 5.5960 0.0776 0.2785 0.1246 
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B.4  Tetracalcium aluminoferrite 
 
Summary 
 

Number of Observations:            8  
Grand Mean:  8.7275  

Grand Standard Deviation:  1.6680  
Total Number of Methods:            2  

Minimum Method Mean:  7.5420  
Maximum Method Mean:  10.7033  

Minimum Method SD:  0.1514  
Maximum Method SD:  0.4154  

Mean of Method Means:  9.1227  
SD of Method Means:  2.2354  

SD of Method Means (wrt to grand mean):  2.3042  
Within Method (pooled) SD:  0.3502  

Within Method (pooled) Variance:  0.1227  
   

Method: BOB (Bound on Bias)    
Estimate of Consensus Mean:  9.1227  

Within Method Uncertainty:  0.1027  
Between Method Uncertainty:   0.9126  
Standard Uncertainty (k = 1):  0.9184  

Expanded Uncertainty (k = 2):  1.8367  
Lower 95 % (k = 2) Confidence Limit:  7.2860  
Upper 95 % (k = 2) Confidence Limit:   10.9594  

 
 
 
Results by method 
 

 
Method 

ID 

 
 
( )n i  

 
 

Mean 

 
 

Variance 

 
Standard 
Deviation 

Standard 
Deviation 

of the Mean 
XRD 3 10.7033 0.0229 0.1514 0.0874 
SEM 5         7.5420 0.1725 0.4154 0.1858 
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B.5  Periclase 
 
Summary 
 

Number of Observations:            8  
Grand Mean:  4.4512  

Grand Standard Deviation:  1.5528  
Total Number of Methods:            2  

Minimum Method Mean:  3.4400  
Maximum Method Mean:  5.0580  

Minimum Method SD:  0.0400  
Maximum Method SD:  1.7297  

Mean of Method Means:  4.2490  
SD of Method Means:  1.1441  

SD of Method Means (wrt to grand mean):  1.1793  
Within Method (pooled) SD:  1.4125  

Within Method (pooled) Variance:  1.9951  
   

Method: BOB (Bound on Bias)    
Estimate of Consensus Mean:  4.2490  

Within Method Uncertainty:  0.3869  
Between Method Uncertainty:   0.4671  
Standard Uncertainty (k = 1):  0.6065  

Expanded Uncertainty (k = 2):  1.2131  
Lower 95 % (k = 2) Confidence Limit:  3.0359  
Upper 95 % (k = 2) Confidence Limit:   5.4621  

 
 
 
Results by method 
 

 
Method 

ID 

 
 
( )n i  

 
 

Mean 

 
 

Variance 

 
Standard 
Deviation 

Standard 
Deviation 

of the Mean 
XRD 3 3.4400 0.0016 0.0400 0.0231 
SEM 5 5.0580 2.9918 1.7297 0.7735 
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B.6  Alkali sulfates 
 
Summary 
 

Number of Observations:            8  
Grand Mean:  0.5625  

Grand Standard Deviation:  0.4228  
Total Number of Methods:            2  

Minimum Method Mean:  0.2000  
Maximum Method Mean:  0.7800  

Minimum Method SD:  0.0173  
Maximum Method SD:  0.3936  

Mean of Method Means:  0.4900  
SD of Method Means:  0.4101  

SD of Method Means (wrt to grand mean):  0.4227  
Within Method (pooled) SD:  0.3216  

Within Method (pooled) Variance:  0.1034  
   

Method: BOB (Bound on Bias)    
Estimate of Consensus Mean:  0.4900  

Within Method Uncertainty:  0.0882  
Between Method Uncertainty:   0.1674  
Standard Uncertainty (k = 1):  0.1892  

Expanded Uncertainty (k = 2):  0.3784  
Lower 95 % (k = 2) Confidence Limit:  0.1116  
Upper 95 % (k = 2) Confidence Limit:   0.8684  

 
 
 
Results by method 
 

 
Method 

ID 

 
 
( )n i  

 
 

Mean 

 
 

Variance 

 
Standard 
Deviation 

Standard 
Deviation 

of the Mean 
XRD 3 0.2000 0.0003 0.0173 0.0100 
SEM 5 0.7800 0.1550 0.3936 0.1760 
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B.7  Calcite 
 
Summary 
 

Number of Observations:            8  
Grand Mean:  2.8463  

Grand Standard Deviation:  0.7119  
Total Number of Methods:            2  

Minimum Method Mean:  2.5860  
Maximum Method Mean:  3.2800  

Minimum Method SD:  0.1411  
Maximum Method SD:  0.8069  

Mean of Method Means:  2.9330  
SD of Method Means:  0.4907  

SD of Method Means (wrt to grand mean):  0.5058  
Within Method (pooled) SD:  0.6639  

Within Method (pooled) Variance:  0.4407  
   

Method: BOB (Bound on Bias)    
Estimate of Consensus Mean:  2.9330  

Within Method Uncertainty:  0.1850  
Between Method Uncertainty:   0.2003  
Standard Uncertainty (k = 1):  0.2727  

Expanded Uncertainty (k = 2):  0.5453  
Lower 95 % (k = 2) Confidence Limit:  2.3877  
Upper 95 % (k = 2) Confidence Limit:   3.4783  

 
 
 
Results by method 
 

 
Method 

ID 

 
 
( )n i  

 
 

Mean 

 
 

Variance 

 
Standard 
Deviation 

Standard 
Deviation 

of the Mean 
XRD 3 3.2800 0.0199 0.1411 0.0814 
SEM 5 2.5860 0.6511 0.8069 0.3609 
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B.8  Gypsum 
 
Note: This analysis includes gypsum, bassanite, and anhydrite forms together.  
 
Summary 
 

Number of Observations:            8  
Grand Mean:  2.7237  

Grand Standard Deviation:  0.3777  
Total Number of Methods:            2  

Minimum Method Mean:  2.4700  
Maximum Method Mean:  3.1467  

Minimum Method SD:  0.0462  
Maximum Method SD:  0.1843  

Mean of Method Means:  2.8083  
SD of Method Means:  0.4785  

SD of Method Means (wrt to grand mean):  0.4932  
Within Method (pooled) SD:  0.1528  

Within Method (pooled) Variance:  0.0233  
   

Method: BOB (Bound on Bias)    
Estimate of Consensus Mean:  2.8083  

Within Method Uncertainty:  0.0433  
Between Method Uncertainty:   0.1953  
Standard Uncertainty (k = 1):  0.2001  

Expanded Uncertainty (k = 2):  0.4002  
Lower 95 % (k = 2) Confidence Limit:  2.4082  
Upper 95 % (k = 2) Confidence Limit:   3.2085  

 
 
 
Results by method 
 

 
Method 

ID 

 
 
( )n i  

 
 

Mean 

 
 

Variance 

 
Standard 
Deviation 

Standard 
Deviation 

of the Mean 
XRD 3 3.1467 0.0021 0.0462 0.0267 
SEM 5 2.4700 0.0339 0.1843 0.0824 
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B.9  Dolomite 
 
Summary 
 

Number of Observations:            8  
Grand Mean:  0.7475  

Grand Standard Deviation:  0.5882  
Total Number of Methods:            2  

Minimum Method Mean:  0.5460  
Maximum Method Mean:  1.0833  

Minimum Method SD:  0.0252  
Maximum Method SD:  0.6855  

Mean of Method Means:  0.8147  
SD of Method Means:  0.3800  

SD of Method Means (wrt to grand mean):  0.3916  
Within Method (pooled) SD:  0.5599  

Within Method (pooled) Variance:  0.3135  
   

Method: BOB (Bound on Bias)    
Estimate of Consensus Mean:  0.8147  

Within Method Uncertainty:  0.1534  
Between Method Uncertainty:   0.1551  
Standard Uncertainty (k = 1):  0.2182  

Expanded Uncertainty (k = 2):  0.4364  
Lower 95 % (k = 2) Confidence Limit:  0.3783  
Upper 95 % (k = 2) Confidence Limit:   1.2510  

 
 
 
Results by method 
 

 
Method 

ID 

 
 
( )n i  

 
 

Mean 

 
 

Variance 

 
Standard 
Deviation 

Standard 
Deviation 

of the Mean 
XRD 3 1.0833 0.0006 0.0252 0.0145 
SEM 5 0.5460 0.4699 0.6855 0.3066 
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B.10  Quartz 
 
Summary 
 

Number of Observations:            8  
Grand Mean:  0.6250  

Grand Standard Deviation:  0.6160  
Total Number of Methods:            2  

Minimum Method Mean:  0.2000  
Maximum Method Mean:  0.8800  

Minimum Method SD:  0.0265  
Maximum Method SD:  0.6686  

Mean of Method Means:  0.5400  
SD of Method Means:  0.4808  

SD of Method Means (wrt to grand mean):  0.4956  
Within Method (pooled) SD:  0.5461  

Within Method (pooled) Variance:  0.2982  
   

Method: BOB (Bound on Bias)    
Estimate of Consensus Mean:  0.5400  

Within Method Uncertainty:  0.1497  
Between Method Uncertainty:   0.1963  
Standard Uncertainty (k = 1):  0.2469  

Expanded Uncertainty (k = 2):  0.4937  
Lower 95 % (k = 2) Confidence Limit:  0.0463  
Upper 95 % (k = 2) Confidence Limit:   1.0337  

 
 
 
Results by method 
 

 
Method 

ID 

 
 
( )n i  

 
 

Mean 

 
 

Variance 

 
Standard 
Deviation 

Standard 
Deviation 

of the Mean 
XRD 3 0.2000 0.0007 0.0265 0.0153 
SEM 5 0.8800 0.4470 0.6686 0.2990 
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8.  Appendix C. Consensus Phase Mass Percentage Values for Cement 3-74 
 
C.1  Alite 
 
Summary 
 

Number of Observations:            9  
Grand Mean:  58.2322  

Grand Standard Deviation:  2.0933  
Total Number of Labs:            2  

Minimum Lab Mean:  57.8783  
Maximum Lab Mean:  58.9400  

Minimum Lab SD:  0.6963  
Maximum Lab SD:  2.5232  

Mean of Lab Means:  58.4092  
SD of Lab Means:  0.7507  

SD of Lab Means (wrt to grand mean):  0.7913  
Within Lab (pooled) SD:  2.1647  

Within Lab (pooled) Variance:  4.6860  
   

Method: BOB (Bound on Bias)    
Estimate of Consensus Mean:  58.4092  

Within Lab Uncertainty:  0.5529  
Between Lab Uncertainty:   0.3065  

Standard Uncertainty (k = 1):  0.6321  
Expanded Uncertainty (k = 2):  1.2643  

Lower 95 % (k = 2) Confidence Limit:  57.1449  
Upper 95 % (k = 2) Confidence Limit:   59.6735  

 
 
 
Results by method 
 

 
Method 

ID 

 
 
( )n i  

 
 

Mean 

 
 

Variance 

 
Standard 
Deviation 

Standard 
Deviation 

of the Mean 
XRD 3 58.9400 0.4849 0.6963 0.4020 
SEM 6 57.8783 6.3665 2.5232 1.0301 
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C.2  Belite 
 
Summary 
 

Number of Observations:            9  
Grand Mean:  11.7378  

Grand Standard Deviation:  1.8572  
Total Number of Labs:            2  

Minimum Lab Mean:  10.7967  
Maximum Lab Mean:  12.2083  

Minimum Lab SD:  0.7893  
Maximum Lab SD:  2.1148  

Mean of Lab Means:  11.5025  
SD of Lab Means:  0.9982  

SD of Lab Means (wrt to grand mean):  1.0522  
Within Lab (pooled) SD:  1.8365  

Within Lab (pooled) Variance:  3.3726  
   

Method: BOB (Bound on Bias)    
Estimate of Consensus Mean:  11.5025  

Within Lab Uncertainty:  0.4881  
Between Lab Uncertainty:   0.4075  

Standard Uncertainty (k = 1):  0.6359  
Expanded Uncertainty (k = 2):  1.2717  

Lower 95 % (k = 2) Confidence Limit:  10.2308  
Upper 95 % (k = 2) Confidence Limit:   12.7742  

 
 
 
Results by method 
 

 
Method 

ID 

 
 
( )n i  

 
 

Mean 

 
 

Variance 

 
Standard 
Deviation 

Standard 
Deviation 

of the Mean 
1 3 10.7967 0.6230 0.7893 0.4557 
 6 12.2083 4.4724 2.1148 0.8634 
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C.3  Tricalcium aluminate 
 
Summary 
 

Number of Observations:            9  
Grand Mean:  9.0789  

Grand Standard Deviation:  1.3975  
Total Number of Labs:            2  

Minimum Lab Mean:  9.0217  
Maximum Lab Mean:  9.1933  

Minimum Lab SD:  0.0451  
Maximum Lab SD:  1.7641  

Mean of Lab Means:  9.1075  
SD of Lab Means:  0.1214  

SD of Lab Means (wrt to grand mean):  0.1280  
Within Lab (pooled) SD:  1.4912  

Within Lab (pooled) Variance:  2.2235  
   

Method: BOB (Bound on Bias)    
Estimate of Consensus Mean:  9.1075  

Within Lab Uncertainty:  0.3603  
Between Lab Uncertainty:   0.0496  

Standard Uncertainty (k = 1):  0.3637  
Expanded Uncertainty (k = 2):  0.7275  

Lower 95 % (k = 2) Confidence Limit:  8.3800  
Upper 95 % (k = 2) Confidence Limit:   9.8350  

 
 
 
Results by method 
 

 
Method 

ID 

 
 
( )n i  

 
 

Mean 

 
 

Variance 

 
Standard 
Deviation 

Standard 
Deviation 

of the Mean 
XRD 3 9.1933 0.0020 0.0451 0.0260 
SEM 6 9.0217 3.1121 1.7641 0.7202 
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C.4  Tetracalcium aluminoferrite 
 
Summary 
 

Number of Observations:            9  
Grand Mean:  9.1078  

Grand Standard Deviation:  1.1585  
Total Number of Labs:            2  

Minimum Lab Mean:  9.0717  
Maximum Lab Mean:  9.1800  

Minimum Lab SD:  0.0866  
Maximum Lab SD:  1.4628  

Mean of Lab Means:  9.1258  
SD of Lab Means:  0.0766  

SD of Lab Means (wrt to grand mean):  0.0807  
Within Lab (pooled) SD:  1.2372  

Within Lab (pooled) Variance:  1.5306  
   

Method: BOB (Bound on Bias)    
Estimate of Consensus Mean:  9.1258  

Within Lab Uncertainty:  0.2996  
Between Lab Uncertainty:   0.0313  

Standard Uncertainty (k = 1):  0.3013  
Expanded Uncertainty (k = 2):  0.6025  

Lower 95% (k = 2) Confidence Limit:  8.5233  
Upper 95% (k = 2) Confidence Limit:   9.7284  

 
 
 
Results by method 
 

 
Method 

ID 

 
 
( )n i  

 
 

Mean 

 
 

Variance 

 
Standard 
Deviation 

Standard 
Deviation 

of the Mean 
XRD 3 9.1800 0.0075 0.0866 0.0500 
SEM 6 9.0717 2.1398 1.4628 0.5972 
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C.5  Periclase 
 
Summary 
 

Number of Observations:            9  
Grand Mean:  1.5489  

Grand Standard Deviation:  0.3573  
Total Number of Labs:            2  

Minimum Lab Mean:  1.5400  
Maximum Lab Mean:  1.5667  

Minimum Lab SD:  0.0058  
Maximum Lab SD:  0.4516  

Mean of Lab Means:  1.5533  
SD of Lab Means:  0.0189  

SD of Lab Means (wrt to grand mean):  0.0199  
Within Lab (pooled) SD:  0.3817  

Within Lab (pooled) Variance:  0.1457  
   

Method: BOB (Bound on Bias)    
Estimate of Consensus Mean:  1.5533  

Within Lab Uncertainty:  0.0922  
Between Lab Uncertainty:   0.0077  

Standard Uncertainty (k = 1):  0.0925  
Expanded Uncertainty (k = 2):  0.1850  

Lower 95 % (k = 2) Confidence Limit:  1.3683  
Upper 95 % (k = 2) Confidence Limit:   1.7384  

 
 
 
Results by method 
 

 
Method 

ID 

 
 
( )n i  

 
 

Mean 

 
 

Variance 

 
Standard 
Deviation 

Standard 
Deviation 

of the Mean 
XRD 3 1.5667 0.0000 0.0058 0.0033 
SEM 6 1.5400 0.2039 0.4516 0.1844 
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C.6  Alkali sulfates 
 
Summary 
 

Number of Observations:            9  
Grand Mean:  1.7344  

Grand Standard Deviation:  0.2466  
Total Number of Labs:            2  

Minimum Lab Mean:  1.6767  
Maximum Lab Mean:  1.8500  

Minimum Lab SD:  0.0173  
Maximum Lab SD:  0.2919  

Mean of Lab Means:  1.7633  
SD of Lab Means:  0.1226  

SD of Lab Means (wrt to grand mean):  0.1292  
Within Lab (pooled) SD:  0.2468  

Within Lab (pooled) Variance:  0.0609  
   

Method: BOB (Bound on Bias)    
Estimate of Consensus Mean:  1.7633  

Within Lab Uncertainty:  0.0598  
Between Lab Uncertainty:   0.0500  

Standard Uncertainty (k = 1):  0.0780  
Expanded Uncertainty (k = 2):  0.1559  

Lower 95 % (k = 2) Confidence Limit:  1.6074  
Upper 95 % (k = 2) Confidence Limit:   1.9193  

 
 
 
Results by method 
 

 
Method 

ID 

 
 
( )n i  

 
 

Mean 

 
 

Variance 

 
Standard 
Deviation 

Standard 
Deviation 

of the Mean 
XRD 3 1.8500 0.0003 0.0173 0.0100 
SEM 6 1.6767 0.0852 0.2919 0.1192 
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C.7  Calcite 
 
Summary 
 

Number of Observations:            9  
Grand Mean:  1.3189  

Grand Standard Deviation:  0.3846  
Total Number of Labs:            2  

Minimum Lab Mean:  1.2833  
Maximum Lab Mean:  1.3900  

Minimum Lab SD:  0.1000  
Maximum Lab SD:  0.4776  

Mean of Lab Means:  1.3367  
SD of Lab Means:  0.0754  

SD of Lab Means (wrt to grand mean):  0.0795  
Within Lab (pooled) SD:  0.4071  

Within Lab (pooled) Variance:  0.1658  
   

Method: BOB (Bound on Bias)    
Estimate of Consensus Mean:  1.3367  

Within Lab Uncertainty:  0.1017  
Between Lab Uncertainty:   0.0308  

Standard Uncertainty (k = 1):  0.1062  
Expanded Uncertainty (k = 2):  0.2125  

Lower 95 % (k = 2) Confidence Limit:  1.1242  
Upper 95 % (k = 2) Confidence Limit:   1.5491  

 
 
 
Results by method 
 

 
Method 

ID 

 
 
( )n i  

 
 

Mean 

 
 

Variance 

 
Standard 
Deviation 

Standard 
Deviation 

of the Mean 
XRD 3 1.3900 0.0100 0.1000 0.0577 
SEM 6 1.2833 0.2281 0.4776 0.1950 
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C.8  Gypsum 
 
Note: This analysis includes gypsum, bassanite, and anhydrite forms together.  
 
Summary 
 

Number of Observations:            9  
Grand Mean:  3.8378  

Grand Standard Deviation:  0.5000  
Total Number of Labs:            2  

Minimum Lab Mean:  3.5583  
Maximum Lab Mean:  4.3967  

Minimum Lab SD:  0.0666  
Maximum Lab SD:  0.3422  

Mean of Lab Means:  3.9775  
SD of Lab Means:  0.5928  

SD of Lab Means (wrt to grand mean):  0.6249  
Within Lab (pooled) SD:  0.2914  

Within Lab (pooled) Variance:  0.0849  
   

Method: BOB (Bound on Bias)    
Estimate of Consensus Mean:  3.9775  

Within Lab Uncertainty:  0.0724  
Between Lab Uncertainty:   0.2420  

Standard Uncertainty (k = 1):  0.2526  
Expanded Uncertainty (k = 2):  0.5052  

Lower 95 % (k = 2) Confidence Limit:  3.4723  
Upper 95 % (k = 2) Confidence Limit:   4.4827  

 
 
 
Results by method 
 

 
Method 

ID 

 
 
( )n i  

 
 

Mean 

 
 

Variance 

 
Standard 
Deviation 

Standard 
Deviation 

of the Mean 
XRD 3 4.3967 0.0044 0.0666 0.0384 
SEM 6 3.5583 0.1171 0.3422 0.1397 
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C.9  Dolomite 
 
Summary 
 

Number of Observations:            9  
Grand Mean:  1.8867  

Grand Standard Deviation:  0.9424  
Total Number of Labs:            2  

Minimum Lab Mean:  1.8733  
Maximum Lab Mean:  1.9133  

Minimum Lab SD:  0.1607  
Maximum Lab SD:  1.1874  

Mean of Lab Means:  1.8933  
SD of Lab Means:  0.0283  

SD of Lab Means (wrt to grand mean):  0.0298  
Within Lab (pooled) SD:  1.0072  

Within Lab (pooled) Variance:  1.0145  
   

Method: BOB (Bound on Bias)    
Estimate of Consensus Mean:  1.8933  

Within Lab Uncertainty:  0.2468  
Between Lab Uncertainty:   0.0115  

Standard Uncertainty (k = 1):  0.2470  
Expanded Uncertainty (k = 2):  0.4941  

Lower 95 % (k = 2) Confidence Limit:  1.3992  
Upper 95 % (k = 2) Confidence Limit:   2.3874  

 
 
 
Results by method 
 

 
Method 

ID 

 
 
( )n i  

 
 

Mean 

 
 

Variance 

 
Standard 
Deviation 

Standard 
Deviation 

of the Mean 
XRD 3 1.9133 0.0258 0.1607 0.0928 
SEM 6 1.8733 1.4099 1.1874 0.4848 
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C.10  Quartz 
 
Summary 
 

Number of Observations:            9  
Grand Mean:  0.4167  

Grand Standard Deviation:  0.2263  
Total Number of Labs:            2  

Minimum Lab Mean:  0.4000  
Maximum Lab Mean:  0.4500  

Minimum Lab SD:  0.1908  
Maximum Lab SD:  0.2577  

Mean of Lab Means:  0.4250  
SD of Lab Means:  0.0354  

SD of Lab Means (wrt to grand mean):  0.0373  
Within Lab (pooled) SD:  0.2405  

Within Lab (pooled) Variance:  0.0578  
 
 
 
Results by method 
 

 
Method 

ID 

 
 
( )n i  

 
 

Mean 

 
 

Variance 

 
Standard 
Deviation 

Standard 
Deviation 

of the Mean 
XRD 3 0.4500 0.0364 0.1908 0.1102 
SEM 6 0.4000 0.0664 0.2577 0.1052 
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